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You Have a Choice

In an era where new programs, computers, and services crop up
every day, it's odd that there hasn't been much of a choice for
the tool that you probably use more than anything else: your
office suite. Your reports and documentation, office or home
budgets, and presentations are all completed with the default
office suite. 

There were others, sure. But if you wanted something different,
you risked compromising features; it was unlikely that anyone
else could open the documents; and you might not find what
you needed on the platform you use. Worse, it could be hard to
learn, require massive migration to the new system, and
generally cause a huge hassle.

Sun is actively investing in office productivity solutions. With
the StarOffice™ application suite, Sun provides  a real choice.
There isn't a more full-featured, easy-to-use set of applications
available, and StarOffice software is designed to make your life
simpler. It's easy to own, since it's the most affordable office
suite by far. It's open source and it runs on the Solaris™

Operating Environment, Linux, and Microsoft Windows, the
same way on each platform. And that's just the beginning.

StarOffice Means Compatibility: You Can
Open Any File

The StarOffice suite peacefully coexists with Microsoft Office;
you can run them on the same computer, open Microsoft
documents in StarOffice and edit them, and save them back in
their original format again when you're done. Though after
using StarOffice software, you just might find that you just
don't need another office suite — or costly upgrades — any more.
And compatibility with Microsoft formats is better than ever.

Moving beyond Microsoft, the StarOffice Open File dialog box
lists 145 different formats. The StarOffice suite expertly opens
and interprets files created by such diverse applications as
Microsoft Word, WordStar, and AmiPro; Excel, Lotus 1-2-3, and
PowerPoint; and all standard raster graphics formats, plus
Adobe Photoshop and FrameMaker. There's even a conversion
AutoPilot to help you quickly convert a batch of Microsoft files
at once. You might never have to say “I can't open your file”
again. 
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StarOffice Means Vision: Building a
Bridge to the Future

Everywhere you turn these days, the talk is  about wireless — the
feature-rich, technologically advanced cell phones and PDAs
being developed as well as those already on the market. The
StarOffice suite is ready to work with these technologies
utilizing the PalmPilot sync feature, which lets you synchronize
your Palm OS-based PDA to your online address book.

Another significant technology that ushers in new possibilities
is XML; there's a worldwide rush to implement this open
technology. The StarOffice program's XML-based files embrace
this approach, enabling you to be part of the XML revolution.
XML formats are fully documented, encouraging its adoption as
an industry standard.

The progressive technologies that the StarOffice application
suite embraces don't stop there. You get a seamless path to the
next generation of computing and wireless devices, the Sun™

ONE Webtop. You can integrate with emerging desktops like
Linux and GNOME. The StarOffice code is open source, so it
leverages the power of developers worldwide through
OpenOffice.org, joining other successful open source projects,
such as the Linux environment. The same open, progressive
approach applies when you install StarOffice software; there's
no forced registration, so your privacy is protected. 

StarOffice Means Savings: A Fully
Supported, Low-Cost Alternative

StarOffice software costs about 86 percent less than Microsoft's
office suite, without costly upgrades, and offers twice as many
applications. You can find the  StarOffice suite on Amazon.com
or FatBrain.com; you can buy it at retail computer stores; you
can even download it directly from Sun Microsystems at 
http://www.sun.com/staroffice. It takes just a few minutes to

Product Guide 5



install, since there's no complicated enforced system of
registration. If you've got access to a computer right now, you
could be trying out the StarOffice suite before your coffee gets
cold. 

StarOffice Means
Opportunity: You're in
Charge

StarOffice doesn't burn your bridges,
separating you from other systems; on
the contrary, it builds bridges to new
opportunities. Feeling stuck with your
current proprietary system, in lockstep
with whatever the vendors decide
you're going to do? Welcome to a world
of new opportunities. With the
StarOffice application suite, it's easy to
move to open, non-Microsoft Windows
platforms, since StarOffice software
runs seamlessly on Solaris and Linux
platforms as well. You can do it
immediately or transition more slowly,
since StarOffice runs on Microsoft
Windows and opens all your Microsoft
files. 

If you've been putting off transitioning because of the expense,
you're free of that concern, as well. You can make the transition
to better computing without prohibitive costs. 

After a transition to the StarOffice suite, you'll be poised at the
threshold of the next generation of computing, where open
systems platforms and applications rule. You'll also be building
transferable skills for that world; skills that won't be obsolete
each time another upgrade comes along. 

StarOffice Means Choice: Use the
Platform You Want

The StarOffice application suite doesn't just run on Microsoft
Windows, and it certainly doesn't run differently on various
platforms. You can use StarOffice software on the Solaris and
Linux plaforms, as well. And you can transfer documents among
platforms with no impact on formatting.  

StarOffice Means Ease of Use: Getting up
to Speed in a Snap

Software isn't much use if it takes forever to learn. Very few of
us have unlimited time to learn how to use new software —
we're too busy trying to get something done with it. The
StarOffice team knows and appreciates that, which is why ease
of use is built right into the product. 
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A great interface Thousands of hours of testing and focus
groups go into how you see the StarOffice application suite, so
that when you bring up your first document, the familiar
conventions and clearly labeled options mean you can easily
figure out how to get your work done. 

Multiple platforms, one look
and feel It doesn't make a lot of
sense to make an application
work differently, just because
it's on another platform. So
StarOffice software works the
same way, and StarOffice
documents look the same, no
matter what platform you're on.

Doing the same tasks the same
way StarOffice is a unified office
suite. This means many of its
features, like inserting
hyperlinked graphics and
creating styles, are available
across applications, and work
the same way no matter where
you're using them. Importing a spreadsheet into your annual
report works the same way as adding it to your Web page, a
presentation, or a drawing. Learn once, do it anywhere! 

Working on AutoPilot When you're creating new documents,
presentations, or Web pages, you can let the AutoPilot guide you
through the process. Just give the AutoPilot the information it
asks for, and it does the rest. In just a few seconds, you can have
a fully formatted document, ready for your content. 

Guidance the way you want it If you're switching an entire
office team over to the StarOffice application suite, or just want
a more structured introduction to using it, you'll find a number
of great resources. With StarOffice
6.0, the online help offers a much
easier to use interface and thorough
information on StarOffice software.
In addition, training, support, and a
variety of books are available from
Sun Microsystems. From an online
knowledge database to enterprise-
level service, choose the high-quality
support program that best suits your
unique needs. Training programs
accommodate different learning
styles with a choice of Web-based
courses; low-cost, instructor-led
classroom training; customized on-
site classes; and CD-ROM courseware. 
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StarOffice Means Value:
Never Compromising on
Features

The StarOffice feature set leaves
nothing to be desired. It's a
mature product with everything
you need to create whatever you
need for professional and personal
use. 

� Dynamic, animated
presentations

� Well formatted, attractive
text documents; even
business cards and labels

� Complex spreadsheets
with charts and formulas

� High-quality graphics and
drawings

� Sophisticated Web pages
with advanced
components 

� Accessing and managing
databases of the
important information
your business or home
runs on

StarOffice Means
Productivity:
Working More Efficiently

Single-source: you've heard about it, but the StarOffice suite
helps you achieve it. You can turn text documents into Web
pages or presentations; change text documents, presentations,
or spreadsheets into HTML; use a spreadsheet as a mail merge
data source. A single presentation file becomes both handouts
and speaker notes, and when you need multiple versions of the
presentation, just create several custom documents based on
the same file. Develop an animated GIF for your presentation
page, then add it to other documents. Automatically generate a
presentation based on a Writer document. If you've got the
information in one form and need it in another, you'll usually
be able to convert i,t rather than retyping or cutting and
pasting. The StarOffice applications work together to minimize
unnecessary work and help you be as productive as possible.
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StarOffice Means You Have a Choice
Low cost, ease of use, open source, no commitment to one
company, no costly upgrades every time you turn around. No
forced registration, so your privacy is protected It's StarOffice
6.0.

If you think a full-featured office suite for about a tenth of the
cost of the others sounds interesting; an office suite with
support, training, and the power of Sun Microsystems behind it,
then we think you'll like the StarOffice application suite. A lot.
Keep on reading; the next couple of pages gives you a five-
minute overview of the most important StarOffice features.
After that, read on for  more detail about how you can get the
maximum value out of StarOffice software.
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The Five-Minute Guide to StarOffice 

StarOffice is the open source, high-value office suite you've been waiting for. In this section,
we've boiled down the basics, so you can quickly find out how to get going with StarOffice
software, and what its various applications enable you to do. 

To demonstrate how you can really benefit from using StarOffice software, we've included a
variety of scenarios. These show how, in real-life situations under time pressure, budget
limitations, and the usual unforeseen circumstances, the StarOffice application suite will help
you  get your work done. Not just  everyday tasks; but also the things you always wanted to
do, but didn't have the right tools.

StarOffice Features: the Highlights
Since StarOffice applications are designed to work together, many features apply to all of
them, including XML file formats, Unicode support, and an open development APIs. In
addition, standard features like text formatting as well as inserting a variety of images and
other objects are available throughout the StarOffice applications.

StarOffice Writer/Web: Powerful Desktop Publishing,
HTML, and More
Writer, the word processing tool, has what you need
for simple letter writing or complex high-demand
tasks. For example, it manages paragraph and page
styles more intuitively, has better capabilities for
creating multifile books, and lets you make
calculations in tables, including spreadsheets. Setting
up a form letter for mass mailing to contacts in a
database is a simple drag-and-drop procedure. You can
also print the letters, send them to a file for later
printing, or send them directly through e-mail. And a
handy clipart gallery can be easily inserted, without
opening a separate art program. 

Sophisticated indexing functions help define
bibliographical and index entries and keywords, as
well as generate indexes and reference tables (such as
a table of contents). Keeping track of different versions
is a snap for Writer, as it is for all StarOffice applications. Flexible layout and design options
make it a snap to create multicolumn newsletters and brochures. The StarOffice suite also has
an AutoPilot that automatically converts all your Microsoft templates to StarOffice templates
in one pass.

Publishing your own home page or updating intranet pages is as simple as writing a
document. Even if you don't know HTML, you can create sophisticated Web pages with
hyperlinks from text or  graphics, plus icons, scrolling marquees, and image maps. Save a
Writer document as a Web page or start over with one of the many existing Web page layouts.
Hyperlink capabilities, such as linking a graphic to a URL or file, opening a new StarOffice file,
or going to a newsgroup, are available throughout the StarOffice suite.
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StarOffice Calc: Comprehensive and Highly
Programmable Spreadsheet
The StarOffice Calc application offers
more functions than a standard
spreadsheet program, enabling you to
analyze figures, create lists, and
handle Euro conversions with ease
and accuracy. An advanced, intuitive
scenario manager helps analyze and
filter your data according to various
factors, creating if/then situations
that help you make the best decision.
Several advanced layout functions
simplify the task of presenting your
data. And for the finishing touch,
create impressive 3-D charts with
only a few mouse clicks. Importing
and exporting Microsoft Excel
spreadsheets is a snap with the
import AutoPilot, and a simple
delimited text file is all you need to
move data from any other source into (or out of) Calc. 

StarOffice Base: Connect to a World of Databases
A powerful data management tool, StarOffice Base enables you to manage access to existing
databases with ease. It is your intermediary for  connections
between StarOffice documents and the databases you want
them to access. Whether it's a StarOffice Calc spreadsheet,
dBase, JDBC, ODBC3, or other database, Base helps get the
information into your documents. And picking the fields you
want is as easy as double-clicking. A fully populated
bibliography database, and an address book AutoPilot for
connecting to your existing address book, are also included.

StarOffice Impress: Bring Your
Message to Life
The StarOffice Impress application enables you to quickly create impressive presentations,
either from scratch or by importing existing Microsoft PowerPoint presentations. Special
effects and vector graphics tools from Draw (read more about Draw next) enable you to create
stunning animations and text effects with sounds. A wide array of templates and layouts,
plus an intuitive AutoPilot, make it fast and easy to create presentations. 
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The powerful style creation features let you
define exactly how you want the text and
objects to appear, and to apply that
formatting quickly. Multiple views, such as
Handouts and Speaker Notes, enable you to
create multiple types of output for a
presentation, while the custom slideshow
feature lets you pick and choose slides from
the main file to create different presentations
for different audiences. Just put your content
in Impress and use it any way you want. 

To go on the road with your presentation, just
use the Pack feature to compress it onto a few
diskettes, and load the small-footprint Impress
viewer on your laptop. StarOffice Player lets
you read StarOffice Impress and Microsoft
Office presentations without having to load
the full StarOffice program. Using StarOffice Player is a great way to share your presentations
with others over the Web and in remote locations, even with those who have not yet
converted to the StarOffice suite.  

StarOffice Draw: Sophisticated Tools for Professional-
Looking Graphics
The StarOffice Draw vector-based drawing application sports some of the best drawing tools
available in an office suite. Beyond the standard drawing features, Draw includes capabilities
like 3-D shapes and an astounding array of texture and light modifications, Bézier curves, and
precise manipulation tools. Included in Draw and all other StarOffice applications is
FontWork, which lets you curve and otherwise manipulate text as easily as graphics. And any
shape, whether 3-D vector or 2-D raster, can be combined or merged with others in a variety
of ways.
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Draw also includes raster graphics tools, for graphics made up of individual pixels such as
scanned photos. The Eyedropper lets you change any color throughout the graphic; the filters
allows you to apply a variety of effects such as Pop Art and Relief, and StarOffice software's
amazing file support enables you to export your drawings to just about any graphics format
you want.
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StarOffice In Depth: Getting
to Know Each Application

If you're reading this, you've probably recognized that the
StarOffice application suite can make your life a lot easier. In
this section, you'll learn  how StarOffice software does those
things that you've come to expect and depend on, like expert
formatting and an array of spreadsheet functions. You'll also
find that it provides the extras, like the ability to curve text or
create special effects for a presentation, that put the finishing
touches on your work. As well as some features you might not
be using now that can definitely make life easier.

StarOffice: the Highlights
Since StarOffice applications are designed to work together,
many   features apply to all of them. Here are a few of the key
factors that can enhance all of the documents you'll create. In
addition, many of the standard features you'll read about in
Writer, such as a full array of text formatting features and
image handling functions, are available throughout the
StarOffice application suite.

XML File Formats
All of the applications you're going to read about use file
formats that are based on the eXtensible Markup Language
(XML). This means that instead of the older binary-based files,
all the information you put in the file, from the actual content
to how it's formatted or calculated, is stored in the XML format.
Because XML is an open standard, no one company owns it or
can prevent other applications from opening files that are
stored in it. It also means that your file sizes will shrink
dramatically, compared to previous versions of the StarOffice
application suite or current Microsoft Office documents. File
sizes vary according to the objects and formatting they contain,
but a 50-page document in StarOffice Writer, with plenty of text
formatting, can easily be under 80 Kbytes.

Unicode  
StarOffice
software doesn't
just build bridges
between different
technologies and
systems, but
among different
language and
alphabet systems,
as well. The same
open, inclusive
approach means
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the StarOffice application suite is a truly international product,
letting people who speak different languages communicate.
StarOffice 6.0 supports the Unicode Character standard, which
covers the principal written languages of the world. This means
that you can easily create documents that contain characters
from different scripts, such as Western and Cyrillic.  

Asian Language Support   

If you want to write using the  Japanese, Chinese traditional,
Chinese simplified, or Korean languages, the StarOffice
application suite makes it easy. The supporting features include
the “double line in one line” option, which
lets you insert Western text in Asian
character-based documents. There are
additional case options: upper, lower, full
width, and half width, with additional
options for the Japanese languages Katagana
and Hiragana. A “sounds like” option for the
search and replace feature lets you
differentiate among various syllables in
Katakana and Hiragana, as well as ignoring
special characters. 

Whether you're using an Asian language or
just want additional layout options, you'll
find the extra text options extremely useful.
Within text boxes and callouts, you can turn
the text line so that it's vertical. You can also
rotate the characters themselves, up to 270
degrees.

You can also add Ruby  text, which is
explanatory text above the original text, to
explain unusual Japanese words or additional
explanations. Automatic detection helps you find the right Ruby
expression more easily.
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Support for Multiple Languages  
You may choose the language you want installed from a list of
ten languages that includes Korean, German, and Italian. And
regardless of the language you pick, a wide array of
international standards are available, such as special
characters like accents and cedillas, and multiple paper and
envelope sizes. Going international, StarOffice software also
supports the appropriate sort order for all StarOffice 6.0
locales. Three different calendars are now supported to specify
the date in a specific format: besides the Gregorian calendar,
the Japanese Gengou and Korean ROC calendars may also be
used. To specify a number format for a specific locale, you can
take your choice of  more than 90 languages. 

Open Development Environment  
For developers who want to write new programs that interact
with StarOffice software, the StarOffice API now fully supports
C++ and Java  programming languages. Most other
programming and scripting languages can be linked to the
StarOffice API. 

The new API is fully component-orientated, so developers can
create substitute components, encapsulate the components,
embed StarOffice software in their existing workflow systems,
or extend StarOffice software with new components. This means
that any specialized, vertical applications you need can easily be
incorporated into the StarOffice application suite, so you can
leverage its power and out-of-the-box features, but still
customize it and take advantage of  specialized applications for
your industry.

Developers can use the new API to create various graphical user
interfaces (GUIs) — for instance, a  simplified GUI for children, or
adults who need to perform  a limited number of tasks. A
development kit  (http://udk.openoffice.org/udk_package.html)
contains all needed tools.
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AutoPilot for Automatic Connection to Your Address Book
If you're currently using an address book for email or other
purposes, you can easily integrate it for use with StarOffice
documents like automatic mail merges. Whether the address
book is Outlook,  Netscape, or LDAP, the StarOffice AutoPilot lets
you set it up in seconds. 

StarOffice Writer/Web
Writer is everything you need in a word processing, desktop
publishing program. It provides an array of sample documents
and templates. An easy-access toolbar helps you get started
quickly. And powerful formatting tools enable the creation of
complex books, brochures, and other documents. Because Writer
is also HTML-enabled, you also have all these features in
StarOffice Web, the HTML flip side of Writer. Whatever you can
do in one, you can do in the other, whether it's creating
hyperlinks or formatting tables. Which application you use
depends on where the file will end up: on paper or the Web. If
the answer's both, it's easy to switch from one format to the
other.

The main types of features you'll find in StarOffice Writer /Web
are:

StarOffice Writer 

� Basic file creation

� Conversion to and from other formats

� TextfFormatting

� Page layout

� Easy graphics adding and editing

� Adding objects to documents

� Features for books and longer documents

� Version control and editing tools
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� Mailing

� Printing

StarOffice Web

� File creation

� Hyperlinks

� Advanced features

Word Processing Features 
The wide range of features you'll read about on the following
pages are available regardless of whether the underlying
document is in the Writer format or the Web (HTML) format.
Let's look at  some of the features that you'll need for dynamic,
well designed Web pages.

Basic File Creation and Development 

Getting started with text documents Starting a new text
document is simple — just choose  whether you want to create it
from scratch, use one of the powerful StarOffice templates, or
ask AutoPilot to guide you. The standard Writer text document
AutoPilot lets you choose from several letter, fax, agenda, or
memo styles; another AutoPilot for Web pages gives you a
choice of layouts and color themes from elegant to wild.

Autocorrection As you start typing, you might find that
misspelled words change to the right spelling, capitalization
corrects itself, and “1/2” turns to . This is the
AutoCorrect/AutoFormat feature, and it takes care of some of
the “grunt work” for you. You can tailor the corrections to just
what you need, removing some or adding others — or turn it off
completely. 

Autotext  Do you have a lot of  “canned text,” like copyright
statements or specially formatted company letterheads, that
you need to use frequently? In Writer, you don't have to retype
and format these repetitive  items, or copy and paste them from
another document. Just set up the text once as an autotext
entry, and you can add it instantly to any document —
formatted exactly the same as the original text. Before you
create your own, browse through the templates that are
included with the StarOffice application suite, as well.

Navigator Your other main assistant in the StarOffice
application suite is the Navigator, which helps you move
quickly around within a document and between documents.
Navigator is one of the most useful tools in StarOffice, since it's
not only for navigation, but also helps you keep track of
particular types of elements like tables and sections. It can help
organize your document by showing you the top-level view and
allowing you to drag components around within the document
and from other documents. Just press F5 to see this helpful tool.
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Conversion to and From Other
Formats

Opening, editing, and resaving a
Microsoft document  To open an
existing document in a different
format, such as Microsoft Word,
just choose File > Open and point
to the document you want. The
StarOffice filters bring the
document straight in, without
changing its formatting.

Converting a batch of Microsoft
documents to StarOffice format If
you want to convert all your Word, Excel, or PowerPoint
documents to StarOffice format, just use the Document
Converter AutoPilot to handle them all at once. And if you need
the documents in Microsoft format again, choose File > Save As
and pick the file format you want.

Converting to other formats If you need to put StarOffice
Writer documents in other formats for editing or distribution,
nothing could be easier.

� For HTML, choose the Save as command. Or automatically
create multiple HTML files by telling your StarOffice
software to create a different format every  time it finds a
particular paragraph style. (You'll learn more about those
later.) 

� It's a snap to convert Writer documents to create Impress
presentations from them. Choose File > Send and use
Outline to Presentation or AutoAbstract to Presentation.
Apply the appropriate layout and add any necessary
content, and your presentation is done. The Impress
presentations can be easily saved in PowerPoint format.

� Printing to Postscript,
the format you'll need
for professional printing
or to create Adobe PDF
files, is simple. Print to a
file and add the .ps file
extension.

� E-mail documents by
choosing File > Send >
Document as E-mail and
enter the e-mail
addresses. When you
choose to send a
document as e-mail, the
StarOffice application
suite connects to your e-
mail program, such as Netscape Communicator as shown
here, and creates a new e-mail with the document attached. 
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Text Formatting
After you have created a document, you're ready to work. The
toolbars, such as the hyperlink and text formatting bars, help
you quickly complete the most common tasks. 

Note International language support, including Unicode and
special Asian language support, is available in Writer and
throughout the StarOffice application suite. See the beginning
of this section,  “StarOffice: The Highlights,” for more
information.

Full formatting capabilities The accessible Insert, Format, and
Tools menus provide precise control over an array of features.
These dialog boxes give you access to a dizzying number of
features, such as customized bullets, column and page setup,
and precise character spacing.

Vertical text You can turn an entire line of text, or the
characters themselves, up to 270 degrees. 

Styles You'll be more efficient and productive combining the
StarOffice suite's formatting ability into styles: preset
combinations of characters (one or more letters or numbers)
and paragraph styles. StarOffice software includes a number of
existing styles with each of its templates and sample
documents. Use these unchanged, or create and modify styles
using the extensive style creation feature.

Then just apply them to your text using the Stylist or the drop-
down list in the StarOffice work area — the easy way to produce
documents that look the way you want them to.
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The power of StarOffice Stylist is nearly limitless. The
hierarchical nature of styles allows parent and child styles,
where only the deviations to formatting need to be done, such
as bulleted text. What's more, you can copy the formatting of a
"hard" formatted text section and create a style from it, making
it easy to create a professional-looking document.

Numbering and bullets  These powerful tools,  like the other
formatting features, can be applied one-by-one or included as 

styles. The quick-formatting bar lets you quickly turn bullets or
numbering on and off, while the formatting window provides
additional options. Multiple levels of bullets or numbers enable
you to use multiple sets within a document. Spacing control
and graphical bullets are just two of the many features offered.

Templates Going one level up from styles brings us to
templates. Just as styles are preset groups of formatting
characteristics, templates are documents that bring together
several styles. StarOffice 6.0 provides many templates that you
can use as is, or  adapt to your needs. It's easy to create a
template —  open a new text document, make or import the
styles you need, and save the document with template format.
Whenever you want to use that template, just choose File > New
> From Template and select it from the list.
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If the styles you want aren't in your document now, you can
find the template containing them and apply it. Or import
styles from that template into your document's template. All
the options you need are available to customize StarOffice
software to fit your needs.

Page Layout 
The StarOffice application suite enables you to go beyond the
standard American portrait-oriented, letter-size paper. It
supports international paper sizes such as C4, multiple envelope
sizes, and allows you to precisely position body text, headers,
and footers. Multiple columns are supported as well, including
three-column pages and asymmetrical two-column pages. You
can use colors or graphics as the background for a more
dramatic effect, and add borders or shadows around the text
body for emphasis.

Page styles You can save any group of page settings as a page
style, just like character or paragraph styles. Sselect margins,
colors, paper size, and other settings, then save the group under
the page style name you choose. Apply the page style to other
documents, instead of laboriously applying all those settings
again. Page styles, as with other styles, can be applied to and
saved in a template.
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Frames This is a particularly useful
feature for brochures, newsletters, or
other documents with a variety of text
presentation styles. A frame is a box
you can insert anywhere in a document
so the main text flows around it. Inside
the frame, you can put text, objects, or
anything else you like — simply treat it
like normal text. Use the Insert toolbar
menu, or choose Insert > Frame, and tell StarOffice software
what the frame should look like. Many of the same options as
page layout are available, such as colors and columns, plus
options for graphics you insert, including how the text flows
around it. Frames are especially useful when creating columns
of text for newspaper layouts that should flow from one page to
another. StarOffice software frames can even be linked or
connected to each other, so when you add more text to the
frame on the first page, the text automatically flows to the
frame on the next page.

Sections A section is a powerful tool for single sourcing or just
greater layout and content control. You can hide parts of your
document, protect them from edits, or display another file in
your document. You can also use sections to give parts of your
document varying properties, such as a different number of
columns or a colored background. Consider a report you need to
deliver to your manager and the people you supervise.
Information that your employees shouldn't know (or,
conversely, that you need to keep from your manager!) can be
hidden, so you can keep the same source file and deliver it
different ways. Select the text you want (or to make a section of
imported text, simply position your cursor) and choose Insert >
Section. Hide the section based on a condition, or hide it, period.
You can even specify the number of columns for that section.
And when you distribute the document, you can password-
protect sections, even assigning a different password to every
section, so only authorized people can change the text.

Sections are also a very powerful tool for combining files. When
you create a section that's an imported file, changes you make
in the original file are reflected in that section of your
document, too. You could make one document by combining
others that you already have, instead of copying and pasting. If
the information in those documents is updated frequently,
you'll never have to make changes — just update your document
and you'll instantly have the latest information. 

Brochure layout Additional support for single-source
documents, as well as excellent layout capabilities, is available
with the Brochure printing option. This turns your document,
shrinks it, and prints the right pages so you can easily produce
double-sided brochures of any documents. All you need to do is
click Print and mark Brochure. You can do this with Web, Draw,
and Impress documents, as well.
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Easy Graphics Adding and Editing

Here's another way the StarOffice application suite makes it
easy for you to do things quick and simply. 

Scanning or adding a picture If all you need to do is scan in a
picture or two and tweak them in your Writer document, it's as
simple as choosing Insert > Graphics > Scan. Or if you already
have the electronic version and you  need to adjust the picture a
bit — lighter, darker, remove someone from the picture — that's
easy, too. Select the picture and Writer pops up the picture
editing menu. Pick the tools you need and make your changes.

1. Adding effects You can use
the extensive graphics
settings window to specify
options such as how you want
text to wrap around a graphic,
whether readers clicking on it
will find a hyperlink to
another file or URL, and add a
border or background. Other
graphics effects worth noting
include Wrap Contour, which
eliminates the white space
around an image in GIF files,
and Wrap Edit Contour which
lets you modify the outer
lines of a graphic. To access
these and many other graphics tools in the Graphics window,
the Type, Options, Wrap, Hyperlink, Graphics, Crop, Borders,
Background, and Macros tabs give you a wide variety of
quick layout and editing options for modifying your graphics
within Writer and other documents. You don't need to switch
to Draw; just make your changes in the document you're
working in.

Drawing in Writer  It's
also easy to add
drawings to Writer, just
by choosing to show the
Draw toolbar. Then
you're free to add
shapes, lines, and text
boxes, and format them
any way you want. 

Adding Objects and files to Documents
There isn't much you can't insert into a StarOffice document,
whether you're using Writer or the other applications. 
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Plain graphics As you learned in the previous section, you can
insert graphics from a file, or scan them directly into the
document from your. The StarOffice application suite supports
more than 100 graphics formats.

Other text files Insert any text-based file, including Writer,
HTML, ASCII, or Microsoft Word, straight into your Writer
document without having to cut and paste. The file is
completely editable, but still contains its own formatting; it
doesn't take on the styles in your document unless you apply
them.

Formulas and charts  They're not just for spreadsheets. Create

complex formulas like this well-known one: E=mc2

Illustrate data visually by adding formulas and charts to your
documents. Tables in StarOffice Writer easily provide
mathematical functionality, automatically converting a tool bar
so you can add, subtract, and perform basic math without
having to pull out your calculator or switch over to a
spreadsheet application. And any table in your Writer document
can be used as the basis for a chart, including this table and
corresponding illustration. For any table, just select it and
choose Insert > Object > Chart, and StarOffice Writer creates a
chart automatically — all you need to do is choose the chart
format, such as the bar chart shown, pie graph, or many others.

Sales Figures, Fiscal Year 2002 

Quarter
Vacation

Sales
Business

Sales
Total

Q1 $25,025 $325,990 $351,015

Q2 $47,800 $490,022 $537,822

Q3 $49,250 $230,700 $279,950

Q4 $59,100 $199,440 $258,540
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OLE objects 
When you add object
linking and
embedding (OLE) to
your document, the
object is still “alive” —
you can edit it just as
you would in its
original source.  OLE
object functionality
allows you to insert
spreadsheets,
presentations,
drawing, formulas,
and charts that exist
as separate
documents. You can
insert an existing
object, or  create a
new one on the spot,
in your Writer document. And it doesn't even have to be a
StarOffice object — for instance, you can insert an Excel
spreadsheet, too.  When you insert the object and click on it, you
get all the right icons and toolbars to work with the type of
object you've inserted. If you insert a spreadsheet, you get the
Calc toolbars, and so on.

In StarOffice 6.0, OLE formatting is enhanced. This means you
can convert an imported object as an OLE object and then
modify it.

Tables StarOffice tables are powerful
and easy to manage. You can arrange
data in tables and control a variety
of aspects: not only rows and
columns but also relative or absolute
spacing, borders, and headers. You
can take advantage of one of the
many autoformats for your heading,
background, and text formatting. All
StarOffice Writer table autoformats
are the same formats provided in
StarOffice Calc, so you can maintain
the same look across all your
documents. Tables in Writer also provide the ability to perform
mathematical functions directly in your table, such as sum,
multiplication, adding, and more. 

Object captions  After you have a few
graphics or OLE objects, it's convenient to add
captions to them. This enables you to include
explanations or quickly create a table of
contents of all items with captions. Sselect
the object and right-click, choose Caption,
then enter the title and how you want the
caption numbered. 
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Features for Books and Longer Documents
The StarOffice application suite manages the challenges and
special requirements of long documents extremely well. When
you have a long document, like a thousand-page manual or a
500-page training course, it's no longer practical to put all the
information in a single document. One document with 20
chapters is much more unwieldy than 20 files, each
containing one chapter. (Especially if you're on a team of
writers, each assigned to work on several sections.) StarOffice
software provides tools for seamlessly managing multiple
files that belong to the same product.

Master documents  These allow you to manage and link
several files from one parent document where you can
control unified formatting, a single table of contents, or
indexes. This is especially powerful when creating long
documents, such as books or business proposals, with several
separate chapters from different authors. It's simple to create
a master document — choose File > New > Master document. In
the new file, you'll see a window with an insert button, which
you can use to add all the files you want in the order you need
them, or reorder them later. Whenever the imported source files
change, the master document reflects the changes. 

Tables of contents and indexes Most larger documents provide
additional help for readers to navigate, such as a table of
contents, table of figures or other items,  index, or even a
bibliography. You can make all of those with the StarOffice
application suite.

� Table of contents: Choose to insert a table of contents, and
specify how many headings down you want to go. For a
short table of contents, pick Heading1as the lowest; for a
detailed table of contents; choose Heading3 or Heading4.
The table of contents is created from the heading styles. 

� Table of figures or other items: All tables, and anything
you've added a caption to,  can be listed in a table of figures.
Then simply use the indexing tool to create a List of Tables,
or a Table of Objects.

� Indexes: Create index entries using the index entry tool.
While making the entry, you can choose to mark all other
similar occurrences in the same way. This is an incredible
time-saving feature; for instance, if you wanted to make
sure that all occurrences of “StarOffice Writer” in a
document had a corresponding index entry, you'd only need
to do one index entry, and mark the “Apply to all similar
texts” option.
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� Bibliography: As with the other items, add your
bibliography entries (Insert > Indexes > Bibliography Entry),
then run the bibliography. You can store your  entries in the
StarOffice bibliography database (choose Tools >
Bibliography Database) or in a separate document. When
you make the bibliography entry, just specify where the
entry is, and it will be inserted. 

Cross-references  These are vital to delivering solid information
and avoiding unnecessary repetition. In a book on cooking, for
example, you might frequently refer to a basic food preparation
method found on page 25. You can easily insert cross-references
to text and pages. Just insert the marker next to the item you
want to refer to (the food preparation method), then create a
cross-reference to that marker where you want to refer to it. 

Selecting non-consecutive text The StarOffice application suite
has one particular feature that is rather unusual: the ability to
select non-consecutive characters and paragraphs and apply
formatting to them. Try it: select a paragraph, then hold down
Ctrl and select another. 

Version Control and Editing Tools
These tools offer further support for creation of long, complex
documents or anything you're working on over a period of time.
Whether you want  to maintain source code control in each
version of a document, or to easily distribute documents for
review, the StarOffice application suite provides the tools.

Tracking multiple versions Say
you've written a document on
how to set up a TV and VCR, but
you've just received notice that
step 3 of your document isn't
needed anymore. It took you
three days to write that step, and
you're nervous about deleting it.
The solution is to remove it, then
save your current document as a
new  version. It's easy to do —
choose File > Versions and click
Save New Version. All of the
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versions are tracked, and if you need to go back to the original
version, you can do that just as easily. 

Comparing versions If the VCR instructions grow to 100 pages
and you have several versions, or if multiple people have been
working on the document, you may discover that you're no
longer sure which one to use. The compare tool makes it easy to
find the differences between any documents, so you'll know
which one has the information you need to deliver. Open one
document version, then choose File > Versions and select a
version you want to compare it to. Click Compare. You'll soon
see all the differences highlighted and listed in the
Accept/Reject window.

Reviewers' changes Getting feedback on a document from
editors or subject experts is always a challenge. And while
StarOffice Writer can't make people write back to you, it does
provide excellent tools for  reviewers and authors. The author
just chooses Send > As E-mail and enters the reviewers' e-mail
addresses, then clicks Send. Reviewers can easily make changes
to the document using change bars (which simply highlight any
change in content or formatting) and using the record changes
feature to record and list changes or additions they make. 

Accepting or rejecting changes The author can choose to accept
or reject all changes, one by one, or all at once.

Notes If the author wants to put in text that's not part of the
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normal text, such as “This text has been approved
by Marketing” or “This needs verification by
someone with the latest VCR model,” it's easy to to
do with notes. Just choose Insert > Notes and add
the text; the reviewers will see a yellow flag in the
document for each note. Likewise, the reviewers
can add notes, as shown.

Mailings
Whether
you're
sending out
marketing
literature to
customers
and
prospects or
a holiday
newsletter
to your
friends and
family, you
probably don't want to address each envelope or address label
by hand. And the StarOffice mail merge — automatic addressing
— is one of the slickest you'll ever see. The Letter AutoPilot
guides you through the process, letting you specify whatever
data you want, and dictate how it's displayed and formatted.
Then your letter, designed according to your specifications, is
created and displayed. 

The StarOffice application suite also includes several templates
in various styles, with a mail merge field built in.
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Printing
You can produce your document the way you need it, in Writer
or any other document.

Select what elements to print If you don't want to print certain
parts of your document, like graphics, a colored background, or
notes,  unmark them in the Print Options window. Print only
left, or only right, pages. Or print the pages in reverse order.

Tumbling  On double-sided pages, this lets you specify what
side is up when printing the second page. 

PostScript and PDF For output you can send to professional
printers, or for conversion to Adobe's PDF format, print your
document to a file with a .ps extension. 

Print Preview See exactly what your document will look like
before you send it to the printer. Page Preview is now in the
same window as your document, making it easier to manage
your desktop.

Special Features for Web-enabled Documents
Everything you've just read about is available for  use in a
Writer document or  Web page. Here's a few extra features that
you can also use in either type of document, but which were
designed with your Web documents in mind.

Creating and Editing HTML

Getting started with HTML documents Among StarOffice
templates, you have a wide choice, from multiple letter formats
to forms and contracts. Or you can use the AutoPilot to select
from an array of layouts and color schemes. Instead of clicking
and scrolling to where you want it saved, choose the place you
use most  by specifying your main work folder in the Writer
setup options. 
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Easy HTML viewing and editing If you're a hard-core Web
expert and like the control of editing a Web file's HTML yourself,
you can do that easily in the StarOffice application suite. Just
click the View HTML source icon and you can not only see the
HTML but edit it, too. StarOffice software  color codes the HTML
so it's easy to tell what's content and what's markup — use the
defaults or customize the colors for SGML, comments, keywords,
and content. Click the same icon again to immediately see your
changes on the Web page. 

Hyperlinks
Any good Web page should have hyperlinks in it — to related
topics,  previous and subsequent pages, and so on. You get
much more than the basics, with StarOffice Web's powerful
linking features.

Graphics and buttons Most hyperlinks you see are text — “next”
or “for more information.” You can also make a button that
users click, or just apply the hyperlink to a graphic you've
created or scanned in. 

Link to the Internet five ways You can link to the Internet via
HTTP; in addition, you can link to an FTP site or telnet. And this
function is not limited to existing sites; you can turn your Web
page into a communication center by making your hyperlink
open up a new e-mail or newsgroup article, as well. Just select
what you want in the Hyperlink setup window. 
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Link to StarOffice documents The hyperlink features serve you
well within your office, on or off the Internet. If you  want to
create a hyperlink that opens another StarOffice document on
your local hard drive or on the corporate intranet, it's easy to
do. You aren't limited to existing documents, either — the New
Document option lets anyone who clicks on the hyperlink
immediately open up a new blank document, of any StarOffice
type, on their desktop. 

Advanced Features
Hyperlinks are only the beginning of your abilities for creating
dynamic content in the StarOffice application suite. 

Image maps You already know how to  make a graphic link to
another file or site with the basic
hyperlink capabilities. But you
can go far beyond that with image
maps, which enable you to set up
specific areas of a graphic that
link to other sites or files. Image
maps add ease of use and power
to your Web sites and other
documents; instead of hunting
through a list of links about a
building or country, for instance,
why not just put a picture of your
corporate campus on the Web
page and let people click on the
area they're interested in. This is
not just a powerful tool, it'salso
incredibly easy to use. Open the
image map editing window to draw each image map, then enter
a link to the page or file that area will take people when they
click on it. 

Attention-getting marquees When you want people to sit up
and take notice, there's nothing like a marquee. You can add an
animated line of text anywhere you want that constantly scrolls
through the document, horizontally or vertically. Whether
you're advertising a deadline for submitting applications or
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want to add interest to a document, marquees are the easy,
effective way to make sure people see your message.

Animated GIFs Not only can you
animate text, you can make graphics
move on screen, too. You've seen
animated GIFs on Web pages; a series
of different pictures that are quickly
shown in turn. Now you can add them
to documents to get people's attention
or as an artistic enhancement. Use the
Impress features to include animated
GIFs to Web pages or your
presentations. Choose the graphics you
want, then select what order you want
them to be shown. You can draw
attention to a new feature, show a
series of steps for a dance, or simply
flash abstract images.  

Developer Tools
The StarOffice team knows how far
you can go with the Web, so they
included serious tools to take you there. StarOffice supports the
technologies you need for powerful features in your Web pages,
and makes the tools easy to use.

Applets and macros When you  want to add the power of a
programming language to your document, the StarOffice
application suite gives you the options you need. To enhance
your Web page with Java applets, specify where the class file is
and provide the parameters. To run an existing StarOffice Basic
macro or a new one written in StarBasic when users click a
button or graphic, select it from the list in the button or
graphic's setup window. StarBasic is the StarOffice macro
language that you can use to control functionality throughout
the StarOffice application suite. 

Fors and controls, and events The StarOffice suite provides a
tremendously powerful tool through forms and controls. A
control is an item on a Web page such as a pushbutton, radio
button, field to enter information in, and so on. A form is a set
of controls that enable you to accomplish a particular task, such
as entering your name and address information on an online
shopping site.

 

You have a choice of more than a dozen types of controls, and
you can enable forms and controls with a dizzying array of
options. For forms, specify whether to use GET or POST when
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sending the data, whether to analyze SQL commands when the
form is submitted, and so on. 

For the controls, you can make  events happen, such as running
a macro, when a user moves to, clicks on, moves away from, or
performs other actions related to that control. If you're a Web
developer looking for a powerful tool for interactive form
development, StarOffice Web gives you what you need and
more.

StarOffice Calc
Calc is a robust tool that not only has all the spreadsheet
features you'd expect, but draws on the  StarOffice suite's
formula and chart capabilities to enable you to add powerful
mathematical and visual aspects to your work. 

These are the main types of Calc features:

� Basic spreadsheet creation

� Data entry and management

� Controlling display

� Formatting

� Calculating and manipulating data

� Advanced tools

� Adding objects to spreadsheets

� Version control and editing tools

� Printing

Basic Spreadsheet Creation and Development
Start from scratch, or from a template As with other StarOffice
documents, you can get just the amount of help you want when
creating a new spreadsheet. Just make a new blank spreadsheet,
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or base your spreadsheet on one of the templates included with
the StarOffice program. (You can make your own templates, as
well.)

Using sheets  Every spreadsheet has one or more sheets in it —
these are subdocuments within your main spreadsheet
document. They're a good way to keep data organized, separate
but still available for reference or use in other sheets. You can
use cells from one sheet in a calculation in another, for
example. Add as many sheets to the document as you want; or,
if you  need to combine several sheets into one, Calc lets you do
that, as well.

Linking to other spreadsheets  If part of what you need in the
spreadsheet already exists, just link to it — by adding one or
more sheets selected from another spreadsheet, or an entire
spreadsheet. With StarOffice Calc, it's easy to make a document
that contains exactly what you need. If a source spreadsheet
changes, you can automatically update it where you're using it,
or do so manually. And when you need to manage the links to
other spreadsheets by breaking  or updating them, just choose
Edit > Links.

Linking to the Internet Link to anything on the Net that you
need in your spreadsheet, such as financial or stock sources,
using the Currency Converter spreadsheet included with the
StarOffice software.

Importing and Exporting to Other Formats
Calc makes it easy to get your data in whatever form you need,
whether it's in Excel or open source standards like HTML.

Reads and writes Excel Calc reads Microsoft files so easily, they
look almost exactly the same. You can read and edit any Excel
spreadsheet, plus save it back as an Excel file after you're done
working with it. (If you create a StarOffice spreadsheet from
scratch, you can save that in Excel format, as well.) And of
course, if you want to convert all your Excel files to StarOffice
format, the Batch Converter AutoPilot makes it an easy, one-
step process. 
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Any text file can grow up to be a spreadsheet  If you have data
in another file, whether it's a Writer document or another
format, that you want to be in a spreadsheet, there's no need to
retype it or cut and paste. Just make your source file into a
delimited text file — that just means there's something between
each piece of data and the next (the name and address, perhaps)
that tells StarOffice Calc to make a new cell. So all you need to
do is save the source file in plain text and make sure there's a
comma, semicolon, tab, or another character  wherever you
want a new cell. Then open it in Calc and you've got a
spreadsheet. Don't worry if your source files have dates in
English (March 1) rather than numbers; StarOffice Calc reads
and converts them to number formats, no matter what system
language you're using.
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Sending to HTML or text We've already mentioned how easy it
is to make a Calc file into an Excel file. It's also easy to make
spreadsheets into HTML files; just choose File > Save as and pick
HTML. Or, to make a Calc file into a text delimited file that can
be imported into any spreadsheet program, choose the Text
format. 

Calc makes databases easy  If the term “database” usually
makes you nervous,  StarOffice  Calc will cure that. You don't
even need to create a database, since StarOffice documents can
use spreadsheets and other documents as their data source, for
mail merges and other tasks. It's easy to import other databases
into Calc for editing, too. 

Data Entry and Management
The StarOffice design team spends a lot of time with users,
figuring out what common tasks can be made easier. The
features in this section help you boost your productivity and
prevent errors that could steal time from your busy day.

Quick entries with fills One of the simplest but most convenient
features is filling —  this lets you fill a series of cells with the
value in the first cell, or fill a series of cells with incremented
values based on the first cell. For instance, if you want the value
“Colorado” to appear in the State cell for all the rows in a
spreadsheet, just select all the cells and choose Edit > Fill >
Down (or up, or across). To enter a series of numbers,
incremented by any amount, choose Fill > Down.

Quick entries with sort lists  Many column headings are fairly
common— Sunday through Saturday, January through
December, and so on. You can set up sort lists in Calc of
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commonly used values such as
these. Then type just the first
word, such as January, and drag
the mouse through the next 11
cells; the rest of the months
appear automatically in the
appropriate cells.

Quick entries with selection
lists  Sometimes there just
aren't many possible values for
a cell — in an address book for a
particular city, for instance,
there might be only two or
three postal codes. You can see
all the entries for a particular
column by right-clicking on a cell in that column; a selection list
of all the values appears. To automatically enter one of the
values in the current cell, just select it. 

Defining valid entries and online help If you want to give
people a little more leverage, or just make sure you're following
the rules, you can define what kinds of entries are valid for any
cell. Specify whether it can be only a whole number, or in a
particular range. You can even add online help —  guidelines
like, “Enter a number between 1 and 10,” that users can see for
guidance. If they enter the wrong value, your customized error
message pops up.

Controlling Data Display
Hiding and locking rows Hide any cell you want from the
printer just by marking Hide printing option in the cell
attributes window. To prevent anyone else from modifying a
cell, mark it as protected. When they  click on the cell, a message
says that the cell is locked. 
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Nonscrolling regions and screen-splitting How many times
have you scrolled to the bottom of a spreadsheet, only to lose
the headings at the top that tell you what each piece of data
means? 

Calc lets you set up nonscrolling regions so that even when you
scroll down to page 100, the rows you specified are still
showing. This feature isn't just for top rows; you can set up
horizontal nonscrolling regions, vertical nonscrolling regions, or
both. You also can split the window: vertically, horizontally, or
into fourths. Splitting lets you view and work with different
sections of a spreadsheet simultaneously. 

Expanding and contracting spreadsheet sections You can make
your spreadsheet control how it displays much the same way a
file manager navigation window does. Just specify headings at
various levels, and the different headings will expand to show
everything under them, or contract to show nothing. For
example, if you've got three subtotals and a total line, you can
hide everything but the subtotal lines (in contracted mode),
then show the line items that contributed to those figures by
expanding one or more of the subtotal lines. 

Sorting and filtering data As a power user, you want to go
directly to the data you need. In a large document, that requires
the kinds of tools Calc provides. Sorting and filtering let you get
to what you need to know quickly and precisely. 

You can sort by any column in the spreadsheet: name, state, or
total sales, for example. Select up to three columns for sorting,
and specify ascending or descending for each. Sorting options
also let you specify  whether to pay attention to uppercase
versus lowercase, cell formats, and perform vertical or
horizontal sorts. You can even choose to copy the sort to a
named area in the spreadsheet, or to a designated cell or range
on the current or another sheet.

Product Guide 40



Filtering takes Calc's power one step further, to show only the
data you specify. Filter your expenses spreadsheet to show only
meals that cost more than $1,000 per trip, for example. 

To further refine the filtering, just use the intuitive filter setup
window. Here you can filter columns with values equal to,
greater than, or less than the values you specify, plus mark the
filtering options you want, including case sensitivity.

Name sections of the spreadsheet You probably think of your
spreadsheet as having different sections, such as Q1 through Q4
sales data, or expenses and income. Calc lets you name those
areas, which is useful in two ways: you can easily navigate to a
particular section using Navigator, and you can refer to sections
in formulas. You can name one section at a time, or let Calc
create names for sections automatically, based on column or
row headings.

Formatting
Standard formatting support Calc supports the standard text
entry and formatting you've come to expect; you've got it all,
from left or top alignment tochoice of fonts and their  sizes.
You've got full control over the cells, rows, and columns, too:
wrap the text in the cell or make the cell fit the text, for
example. Add borders or background color to emphasize totals
or column headings.

Styles for everything After you've formatted one complex
spreadsheet, you'll understand the advantages of  all that
predefined formatting. It's easy to set up predefined styles for
cells (blue background, Ariel font, thin border) and pages
(landscape orientation, one-inch margins). You also have
"themes" at your disposal. Themes control document-wide
features like background and font; the StarOffice application
suite provides an array of themes you can apply to your
spreadsheets. And of course, Calc (like other StarOffice
applications) comes with predefined templates you can use just
the way they are, or modify. Of course, you can easily create
new templates for your business or personal documents, as well.

Quick, customized autoformats You get a variety of predefined
formats for tables that apply to spreadsheets, too. Make your
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own by just formatting the spreadsheet the way you want it,
then choosing Format > AutoFormat and clicking Add. It'll show
up in the AutoFormat window with all the other predefined
formats.

Color-coded content If you've done any HTML coding, you know
that the different types of values — tags, content, and so on — are
sometimes color coded so you can tell them apart more easily.
Now, Calc brings that same feature to spreadsheet,s so you can
quickly scan documents and find the information you need. Just
turn on the Value Highlighting feature, and you'll see text in
black, plain numbers and dates in blue, and calculated amounts
in green.

Conditional formatting Have you ever gone through a
spreadsheet before a presentation with a highlighter, looking at
the numbers and marking what you want to emphasize? A
budget that's in the red, for example, or great scores on the
latest customer evaluations. Now Calc does that for you with
conditional formatting. Just set up the formatting conditions for
a value in any cell and what happens if the value meets those
conditions. If your positive customer evaluations are over 90
percent, for instance, you could make the number bold, red, and
in 36-point type. 

Calculating and Manipulating Data

Quick sum Powerful calculations are fine, but when you just
want to quickly find the total for some numbers, Calc lets you
do it without a lot of overhead. Just select the cell immediately
under or to the right of the cells that you want to add, and click
the Sum icon on the function bar. Press Enter and the sum
appears. 

Advanced copy and paste options The Paste Special feature lets
you do math just by copying and pasting. For example, copy a
cell that contains the number 2.  When you paste the cell onto a
group of other cells, you can add, subtract, multiply, or divide
by the value you're pasting (in this case, 2). It works well for
pasting plain text or for values generated from a formula.

Spreadsheet calculations: functions, formulas, and operators 
This is the heart and soul of a good spreadsheet, and Calc has
the power you need to do everything but answer the front door.
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Start with a single cell; reference it in a function; then reference
that function's result in another function. There's also a quick,
automatic subtotaling feature that enables you to easily insert
subtotals within a series of numbers. 

The list of functions goes on and on. This release of StarOffice
Calc software has more than  90 new functions, including
business functions like COUPNCD, which returns the next
coupon date after the settlement date; match functions like
BESSELI, which returns the modified Bessel function In(x), and
financial functions like TBILLPRICE, which returns the price of a
$100.00 face value treasury bill.

You get even more when you start using functions such as SUM,
SQRT (square root), and IF. (See the What If? Tools for Real Life
section for some examples of using IF.) 

The Function AutoPilot For more complex calculations, the
Function AutoPilot is your best friend. For any of the hundreds
of functions, it prompts you to add the right kind of data, tells
you what additional data or calculations you can add, and helps
you keep track of  complexities as the calculation grows. There's
almost  no limit to the power you can leverage.

Referring to other cells: relative or absolute One of the basics that
makes spreadsheets so powerful is including cells in
calculations. ((B4 * C3) / D19) It is the foundation of  many
business decisions. Calc gives you a boost, however, by allowing
you not only to refer to cells absolutely in formulas by their
actual location, but relatively, based on their position in relation
to the cell where the formula resides. This means that if you
copy and paste the group of cells so that B4, for example,
becomes X9, your formula still works. 

And that's not all — you can refer to a cell absolutely by row and
relatively by column, or vice versa. If you know that a cell is
always in column D, for example, but goes up and down the
spreadsheet, you can make the column reference absolute and
the row reference relative.
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Checking your formulas Even the most practiced spreadsheet
user occasionally gets an unexpected result, or needs to
backtrack and figure out just how that number got calculated.
Calc makes this easy with the powerful Detective tool that's like
a compiler or debugger for your spreadsheet. It tracks
precedents and errors, marks invalid data, and so on, makig it
easy for you to find and fix problems. With this tool, you can
confidently  base decisions on your spreadsheet calculations. 

Bringing cells together (concatenation) In general, it's a good
idea to keep data as granular as possible — that is, put June's
sales in one cell, July's in another, and the average of the two in
a third, so you can get information that's as specific as possible.
But sometimes you'll want to display separate data in the same
cell, and when you do, Calc has a tool to help. If the
concatenation isn't complicated, use the quick approach by just
selecting the two cells to combine and use an ampersand (&) in
the entry field. To do advanced concatenation with multiple
cells, combining numbers and text strings, use the
CONCATENATE function and list the cells to combine; add any
additional text you want, such as “the total of,” “and,” or “is
equal to.”

What If? Tools for Real Life
With its advanced tools, Calc gives you the power to calculate
nearly anything: not just complex equations, but real-life “what
if?” situations. Formulas provide sophisticated mathematical
support, while goal seek and scenarios help you bring real life
into the picture and make the best choices for critical situations.

Scenarios This is one of the coolest features throughout Calc. It's
like building a little software program on your desktop. With
scenarios, you can quickly find out a formula's result by
selecting different values from cells that the formula is based
on. This means you have a powerful, yet easy-to-use decision-
making tool, easily adaptable to your own circumstances.
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For example, you might want to figure out what your loan
amount would be using different values for the down payment
($10,000 or $20,000), interest rate (7 or 8 percent), and length of
mortgage (10, 20, or 30 years). Jjust set up a scenario with three
cells, enter the different values  for each (so you can select them
from drop down lists), then in a fourth cell, enter a formula that
calculates monthly payments. Or figure out how long a project
will take, based on the number of people working on it, the
number of tasks the project includes, and whether you need a
particular tool to do it. 

Finding how to get what you want with goal seek Goal seek is
another useful tool for figuring out what you need to do to
achieve a certain goal. For instance, Goal seek can help find out
how many people you need to get a project done in a fixed
period of time. Just set up the formula to figure out the end
result, then use goal seek to specify the value for the end result,
let's say six months, and the variable item. Or change the
variable to the number of tasks the project includes, if you
know how many people will be working on the project. 

You could also use goal seek to figure out how much you need
to shave off your expense account in various categories to make
sure the total isn't too high; how much to save each month to
end up with a million dollars in 30 years, or how much you
need to charge a customer to maintain a 20 percent profit
margin.

Using IF and other conditional functions Previously, we
mentioned IF while talking about the functions for performing
calculations. IF and its related functions, including ELSE, AND,
and OR, are among the most powerful tools in Calc. 
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Some sample calculations could include the following:

IF StudentGrade > 69 AND Participation = FALSE OR
StudentGrade > 65 AND Participation = TRUE 

THEN “Pass” ELSE “Fail”

IF  Income >=80,000 AND Expenses  < 60,000 OR (Income
>= 90,000 AND Expenses <= 80% of Income) AND
(InvestmentCondoActualPrice  <= 70% of
InvestmentCondoAssessedPrice) 

THEN “Buy Condo” ELSE “Offer” (80% of
InvestmentCondoAssessedPrice). 

Adding Objects to Spreadsheets
Displaying your results in charts If you've spent time creating
charts by hand or with a less intuitive piece of software, Calc
charts will make your day. To chart information, just select the 

correct cells and choose Insert > Chart. The chart AutoPilot
appears and helps you make the right choices to display your
data: axis titles, type of chart, and so on. Once the chart's
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created, you can easily modify it by dragging the bars or pie
pieces to resize them, or retyping the legend titles. You can use
X, Y, and Z axes. If your data changes, it's a snap to update the
chart, too.

Buttons, graphics, and all the rest  Calc supports the tools
you'll find throughout other StarOffice documents: inserting
graphics and buttons, forms and controls, hyperlinks, and much
more.

Version Control and Editing Tools
Calc leverages the same powerful version control and editing
tools that you read about in Writer. Maintaining and reverting
to specific versions; entering editing changes, then  accepting or
rejecting them; and notes all help you collaborate with others
and produce the final product as efficiently as possible.

StarOffice Base
Base lets you access a variety of databases so you can use that
data in your StarOffice documents. Queries and tables enable
you to filter and sort data to see just what you need. For
instance, set up a query to see only your students with an
average of  95 or above, clients with birthdays this month, or
customers who haven't paid their bills. 

Base is also your tool for setting up the data sources you'll use
for mail merges — those automatic letter and envelope creation
processes that save so much time. 

If you haven't used databases before because they seemed too
complicated, Base can change all that with these basic database
management and creation functions.

Basic Database Management
Manage a variety of data sources You can use databases in a
variety of formats, access them through JDBC, ODBC, and so on.
Or just use Calc or Excel spreadsheets. Base makes it easy with
the data source management tool. The window adapts to the
type of data source you choose, offering you the fields you need
to enter user settings, drivers, URLs, and more. With these
capabilities, you can spend your time creating documents, not
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struggling to get the right data
into them.

You've also have access to your
address books in other formats,
whether they're compatible
with Outlook Express, Outlook,
Mozilla, or LDAP. For any
document, you can choose the
address book you want to work
with.

Sometimes a document is a
database You don't even need a
database to use Base's data source management tools. StarOffice
applications can use a spreadsheet from Calc or  Excel as their
data source, also. 

Importing and exporting databases
Base reads a variety of database
formats: Adabas, dBase, JDBC, ODBC.
So it's easy to link to the databases
you already use. 

To read a database created in
another application, you have a few
different options. If it's one of the
supported formats such as dBase,
there's no extra work at all.
StarOffice Calc supports the
standard delimited text file import
feature, so to import an external
database or any document into Base,
just save it as a delimited text file, open it in Calc, and use the
spreadsheet as your data source.  

Or create a table in Writer and paste it into Calc to turn it into a
spreadsheet data source.

Exporting a StarOffice database so it can be read by another
program is simple. Just save it as a delimited text file and use
the other application to import it.

A relational database on every CD You get an entire relational
database with the StarOffice suite. Adabas D is still bundled
with StarOffice software, and the data source management
window lets you easily manage database attributes such as user
settings and buffer size.

Accessing Data: Mail Merge and More
Mail merge The StarOffice suite's mail merge — automatically
addressing letters and envelopes in Writer — is quick, easy, and
will have you feeling like a power user in minutes. You can use
any of the data sources you've set up in Base, whether they're
databases or just spreadsheets.
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Forms If you  want to create your own form for viewing,
entering, or editing data, it's easy to do with the form and
control tools. You can create forms just like the ones you see in
applications and Web pages; the Form AutoPilot guides you
through selecting the database to use and the fields to put in
each control. 

Then it's easy to call up existing records in a window that you've
created yourself to suit your needs. 

Expanded features available through the forms and controls
management windows let you go even farther through complex
commands and macros.

Tables For relational databases, you often have two or more
tables that make up your database. Base lets you manage these
tables, create new table designs, and delete tables.

Queries A query is just a way of  asking for a specific set of
records. All  customers from New York and Los Angeles, or all
the students with A averages. It's easy to do with the query
AutoPilot, which guides you through selecting your database
and the fields and records you want to see. The tools for
specifying records are powerful — you can choose not only the
records you want to see, but filter out other records, as well. If
you need to view all customers from New York and California
except those with bad credit histories, just tell Calc and that's
what you'll get. Use the query or a database as the source of
information for your documents.
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Reports StarOffice lets you easily produce a text version of your
database, so you can distribute and format it  or do anything
else to make it suit your needs. You can run reports on an entire
database or on a query, so you get all the data or just a select
group. The report is either displayed for you, or simply saved as
a Writer file — you pick the approach you want, each time. 

Sorting and filtering Any database tends to grow over time, and
when you have hundreds or thousands of records, scrolling
through them to find what you need takes too long. StarOffice
Calc lets you get what you need quickly with the ability to sort
by any field or set of fields, and to filter out specified
information. Base supports the same robust filtering and
sorting features provided by Calc.  

StarOffice Impress
Impress helps you create the presentation you need to really get
your point across. It's easy to quickly format a simple
presentation of bullet points, but you've also got the resources
of special effects, sound, animations, and more at your
fingertips.

Draw and Impress are very similar, so we haven't listed all the
features under both sections of this guide. Impress has all of
Draw's graphics capabilities plus many of its own; if you're
interested in a particular drawing feature, check out the Draw
features in this document.

StarOffice Impress offers these special features:

� Presentation creation and development

� Importing and exporting to other formats

� Slide design

� Adding and formatting content

� Special effects
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� Output and delivery

Presentation Creation and Development
If you've ever struggled all night with your software package to
create a presentation for an 8:00 A.M.  meeting, StarOffice
Impress will make sure you never do that again. Whether you're
starting from scratch or use one of  the many  predefined
designs and templates, you'll spend less time getting the file
and formatting together, and more on content.

Put your work on AutoPilot As with other StarOffice
applications, the AutoPilot is there to guide you quickly and
smoothly through creating a new presentation. Select whatever
level of assistance you want, from basing the presentation on an
existing template and layout and adding modifications, to just
picking a nice layout and leaving the rest up to you. It's not just
about layout; the AutoPilot also lets you specify slide transition
information and choose the slides you want from templates.
This release of the StarOffice application suite comes with a new
set of professional-looking designs.

Make your text documents into presentations If you already
have a lot of information for your presentation in another text
document, whether in Writer or another format, it's easy to
convert the document to a presentation. The Outline and
AutoAbstract features let you start from a Writer file, then send
it off to Impress to turn into a presentation. You even get to
control how much of the Writer document is turned into
content — just the headings, a few paragraphs, or bullet points
down into the detail. If you like to cut and paste and duplicate
effort, this feature isn't for you! 
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Easy navigation and slide-swapping The Navigator, a small
window listing the main sections or slides in your document, is
available throughout the StarOffice application suite. It's
particularly useful in Impress, since it simplifies the process of
getting to a particular slide in the current or another
presentation. The Navigator doesn't just take you places, though
— use it to bring in other slides or entire presentations, just by
picking the presentation from a list and dragging the slide you
want. It works the way you might have designed it yourself —
and just as easy to  use. You can also navigate to particular
slides with the intuitive tab system shown at the bottom of the

slide; just click forward or back, and choose the slide you want.

Add, subtract, delete, rearrange You can have everything  your
way with your presentation, especially when it comes to getting
the slides you want, in the order you want them. The tab system
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and a couple of different views let you see all your slides, then
drag them around to rearrange them. If slide 32 needs to be
after slide 5, just drag it over. It really couldn't be simpler. 

To insert a new slide, click and choose New Slide; to delete one,
click on it and choose Delete. And  if you find that you have an
overloaded slide that really needs to be four or five others, one
for each bullet point,  use the Expand Slide command and
Impress does all the slide creation and cutting and pasting for
you. 

See the presentation the way you want Sometimes you want to
see one slide at a time; sometimes you need to see them all at
once. It's convenient to be able to see all the text in one screen
so you can focus on the content, undistracted by the
background and other formatting. Impress displays your work
any  way you want, so you always know where you are and
where you're going. Drawing view (the default) shows the
current slide. Outline view shows the entire presentation with
its headings and indented bullet points, while Slide view shows
the entire presentation graphically. Each lets you drag and drop
slides or individual bullet points with ease. The Notes view
shows the current slide as well as speaker's notes below it for
supporting information, and Handouts view lets you group the
slides onto one sheet of paper, in groups of two to six, for
distribution to your audience.
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Importing and Exporting to Other Formats
Read and write Microsoft's language As with other StarOffice
documents, Impress reads its Microsoft counterpart, as well as
other formats. You can use the batch converter to turn all your
PowerPoint documents to StarOffice and edit them, or just
convert on the fly as you open and edit them. Save any Impress
file in PowerPoint format.

HTML and more Very nearly everything is on the Internet
today, and it's not going to go away. It's easy to make your
presentations part of the information superhighway with the
sophisticated HTML/Webcast export AutoPilot. This conversion
program turns your presentation into separate HTML pages,
with or without frames, and lets you control other aspects like
graphics file compression and navigation buttons for readers. If
you wantan animated graphic, convert it to a Webcast; Impress
makes it easy to select the right options, Perl scripts, and so on.

You can even  define the text encoding for the HTML export,
letting you generate exported HTML files encoded with Unicode
(UTF-8), for example.

Wide array of graphics The problem isn't finding the graphic
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you need, it's learning about all the additional graphics formats
that Impress offers. Export any slide to one of 17 graphics
formats, including popular formats like JPEG, GIF, and the
Internet-friendly PNG format.

Slide Design
Pick your slide layout  There's no page layout work to give your
slide the structure you want. Bullet points, graphics, columns, or
any of a number of other slidelayouts are yours for the
choosing. Select from 12 different page layouts, and Impress
automatically inserts placeholders for charts, graphics, headings,
spreadsheets, and more.

Page size and shape You're not tied to the standard landscape
(wider than it is long) slide dimensions. Choose portrait (longer
than it is wide), landscape, or define your own page dimensions
with an array of controls in the page setup window. You can
even specify ahead of time what to do if the contents of the
page are too big for the printer — shrink everything a bit, or crop
the edges.

Control your background There isn't much you can't put in the
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background of your presentation. Make the background a
simple one-color fill, the company logo, or the picture you took
of the family at the beach last summer. And it's easy to save the
background of one presentation and quickly apply it to other
presentations in the future. You can even use different
backgrounds within the same presentation; and change
backgrounds to separate different types of information or
increase your presentation's impact.

See what you want  For any slide beyond black words on a
white background, it's useful to be able to isolate different parts
of the content to look at one part at a time. Impress lets you do
this with layers. Layers are just what they sound like — partitions
of the slide that display on top of each other. If you're showing
a complex interactive process between engine parts, for
example, you can put each part's system in a different layer in
your slide, so you can show the system separately or in
conjunction with other parts. 

Adding and Formatting Content

Writer's powerful text formatting and graphics too From
quickly formatting a word using the formatting toolbar, to
combining complex text, bullet, and graphic characteristics into
a reusable style, Impress gives you all the power you need to
format text and objects the way you want them. Not only can
you apply styles to text, individually or from preexisting
templates, buty ou can also create and modify styles for
arrowheads, lines, and other graphics. There's no reason to
repeat your formatting tasks in Impress, any more than there is
in Writer. Impress also includes FontWork, the full-featured text-
manipulation program that's available in Writer and
throughout the StarOffice application suite.

StarOffice object insertion This feature works the same as in
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Writer or other StarOffice applications; you can add applets and
plugins, spreadsheets, text files, other presentations, or  objects
to your presentations.

Special Effects
The quarterly sales reports might be what people are there to
hear you talk about, but it's the special effects that keep them
awake and help them remember what you're saying. The
StarOffice application suite gives you scores of amazing features
to keep audiences on their toes, and help you present a
powerful message.

Effects on text A full array of predefined effects lets you bring
text on screen in a way that suits your content. Bring each
bullet point into the slide as you discuss it, from the side or
bottom, or one letter at a time, to the tune of your client's radio
jingle. You can watch each effect in the Impress preview
window, so you know exactly how the effect will look without
having to switch out of the slide and run the presentation.

Effects on objects The same types of text effects are available
for objects. Complex systems can be simplified by adding one
object at a time, letting you slowly introduce concepts before
overwhelming an audience with the whole picture. Flashing,
sounds, and dissolves let you draw attention to particular
elements of your presentation.

Power users will discover they can use the Along a Curve effect
to make any object move along a path. Just draw a line across
the slide, straight across or in any shape or design, then select
any object and set it up to move across the path of the line. 
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Additional effects let you choose from a predefined set of
macros to do your choice of several tasks when the item is
selected: going to a specific slide, playing a sound, opening any
document, making the object invisible, or fading it away. 

Animated GIFs The animated GIFs you read about in the
overview of Web features are also available in Impress. Combine
any series of graphics and tell Impress how long each one
should be displayed, from 1/10 of a second to much longer; the
GIF will run continuously in your presentation.

Slide transition effects When you switch from one slide to
another, it's useful to highlight the whole slide by giving it
some extra panache as it comes on screen. These effects are in
addition to individual text or object effects that are run first —
you can also choose whether they run automatically, or whether
they wait until you click the mouse or press Enter. Pick from
predefined effects like fading in from the center, as well as your
own customized sounds, and control how fast the effect runs.
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Output and Delivery
In some ways, all these development features are only the
beginning, since Impress gives you powerful tools for giving the
best presentation possible. You'll be well rehearsed, perfectly on
time, with excellent audience materials when you use Impress.

Prepared presenter, informed audience A good presentation
becomes a great presentation when both the audience and
presenter have what they need to understand and make
informed decisions. Impress makes it easy for you to distribute
your presentation to the audience, in condensed form — up to
six slides on a page, with headings, page numbers, and any
additional information you want to add to each page. 

It's also easy to include speaker notes; just switch to Notes view
and add anecdotes, illuminating examples, or presentation
advice that only the speaker  will see. The notes and handout
information are attached to the presentation file so that, when
you print, you get to choose what comes out: just the standard
presentation, handouts, notes, or all three.
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Perfect timing The printed word bears some relationship to how
the presentation comes out, but it might not be a close one!
Practicing a presentation  is the only way you'll really know
how it's going, and the Rehearse Timings feature helps you
do that. Just run the presentation the way you normally
would, but under Rehearse Timing's control; the time you spend
on each slide is recorded, plus the total time. So you know how
long that complicated slide on scheduling issues, for example,
really takes to explain.

Write once, present anywhere: customized presentations  If
you've ever given a presentation, you know that you're often
asked to give it again, to a different group. Or you might need
to provide training to people in different classes, of varying
abilities. Regardless, it's a fact that audiences and their needs
vary, and Impress helps you address their needs with
customized presentations. The fully detailed presentation you
gave to your staff can easily be changed to a ten-minute
presentation for management, with no cutting and pasting or
managing two versions. 

Divide and compress Unless you're an Olympic weightlifter, you
won't be taking your desktop computer on the plane with you,
or even up to the second floor. Impress lets you get the
presentation onto a different machine or  your laptop without
using network or Internet connections, and without bothering
with a CD burner. With the convenient Pack feature, Impress
addresses two issues: compressing your presentation file, and
dividing it up onto diskettes. Just choose to run Pack on your
presentation, select the storage format (such as 1.44- Mbytes
diskette) to copy the presentation to, and Impress takes care of
the rest. With Pack, it's easy to copy your 2.5-Mbytes
presentation file onto two diskettes. Once you've copied the
diskettes' contents to your laptop or another computer, Impress
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automatically reassembles the files for you — you don't have to
do a thing.  

Work with the Player Impress comes with a small-footprint
presentation viewer, so you don't need to load all the StarOffice
software on the machine you use to give presentations. It's also
convenient for continuously running presentations in loop
mode, and for kiosks in conventions or stores. Impress Player
contains only the parts of Impress that you need to run your
presentations, with a few running options. It has  command-line
as well as graphical commands, and lets you set up features like
automatic slide transition and presentation looping.

Running To run your presentation in the full StarOffice Impress
program or in Player,  click the presentation and you're off.
That's just the beginning, though. If you're running a
customized presentation, select the version you want. And if
you're expecting feedback, run it in edit mode — it runs like a
presentation with all the effects, but you can still change it as
you go. 

StarOffice Draw
StarOffice Draw is a bonus application, since office suites don't
typically include a graphics program. But if you're going to
create documents with impact, and diagrams that effectively
illustrate the topic, you can't do without one. Draw is a full-
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featured graphics package, and has capabilities for vector
graphics as well as raster graphics.

About rasters and vectors Raster objects are made up of very
small dots, or pixels, grouped together. They may  be scanned
photos or artwork in JPEG, GIF, BMP, or other raster formats.
Vectors are the objects you create with the Draw tools, based on
mathematically calculated lines. Rasters and vectors are
sometimes treated differently; and each has special properties
that let you use them in various ways. 

Draw is similar to Impress and has its own printing capabilities,
including brochure printing. Be sure you've reviewed the
Impress features, as well.

The main types of graphics features in StarOffice Draw are:

� Importing and exporting to other formats

� Basic graphics creation and development

� Text

� Color

� 3D objects 

� Extra object effects

� Positioning and sizing objects

Importing and Exporting to Other Formats

Extensive list of file types Many of the 136 formats in the
Formats list in the StarOffice File > Open window are for
graphics. Whether you just want to open a scanned GIF of your
office party, an Adobe PhotoShop graphic, or an AutoCAD
drawing, StarOffice Draw can open them all, and more. And
when you want to save your Draw files for easy transfer to
another program, you've got 17 choices — everything from  PNG,
metafiles, and SVG, as well as popular options like GIF and JPEG.

Object type conversion Within a drawing, there can be lots of
different types of graphics: standard polygons, metafiles and
bitmaps, lines, curves and contours, text, and two types of 3D
objects. With very few exceptions you can convert one to the
other just by right-clicking and choosing the format you want to
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convert to. If you would like to use an effect on a polygon that
only works on raster files, just convert the polygon to a metafile
or bitmap (both are rasters). Need the object as a polygon again?
Just convert it right back. In the world of StarOffice Draw,
objects can be anything you want them to be.

Basic Graphics Creation and Development
No hoops (just a great circle tool)  Draw has a lot of
sophisticated features, but you'll find it's still easy to get started.
Just create a new drawing from scratch or from a template —
Draw offers all of the usual StarOffice template capabilities, and
comes with a variety of templates ready for you to use. 

Slides for multiple drawings in one document You can
leverage the Impress tab feature to create multiple drawings in
one document. If you have several versions of the same drawing
or components that work together, there's no need to make
separate files. Just click on the slide bar and you have a new
blank slide to draw on.

Square pegs, round holes, everything in between  Squares and
circles, ovals, rounded rectangles, and everything in between are
easy to draw — just click on the shape you want in the toolbar. 

Lines down the street and around the corner Whether it's
straight lines, arrows, or precisely drawn and edited Bezier
curves, Draw has the tools and setup features you need to get
exactly what you want. Use existing arrowheads or customize
them, even create your own shape; the arrowhead can be your
company's logo or the classic triangle, it's up to you. Bezier
curve tools give you an exceptional amount of control, both
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before and after you've drawn the line or curved shape. Add
points afterward and adjust the curve, sharpness, and location
to get exactly the effect you want. 

Precise control with the connector tool and dimension lines 
Draw has the precision tools to enable you to create
engineering-class drawings. Two types of line tools are included
that you don't get with just any drawing program: connectors
and dimension lines. 

Connectors are similar to what you might have seen in Visio; a
smart connector at the end of each line lets you easily attach it
to objects in the drawing, and the line can curve and bend
around each object involved. 

Dimension lines are for use in scale drawings like house plans.
Draw a line with the dimension line tool, and text appears to
automatically display the line's measurement. Position it
against the object you want to indicate the size of, like the
height of a wall or the breadth of a door. Team up the
dimension lines with the scale feature, which lets you choose
scales like 1:2 or 1:16, and you can display the exact
measurements of the object you're illustrating.
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Whether it's UML diagrams,
electric schematics, or
woodworking plans, Draw gives
you the tools you need.

An array of clip art If you've
ever searched the Internet for a
picture of woman's hand,
computer monitor, or snack
tray (and found everything but
what you needed), you'll
appreciate the comprehensive
array of clip art that comes
with StarOffice Draw. Whether
it's business or leisure you
want to represent, you're
bound to find something you
can use in the StarOffice
Gallery.

Custom object fills and more
Once you have the shape you
need, it's easy to complete the
details the way you want them.
Fill any object with a solid
color,  bitmap, crosshatch, or
gradient design, then control
the intensity of the effect with
the Transparency settings. And
you don't just have the option of selecting from the many
StarOffice  fills: you can also create your own bitmaps,
crosshatches, gradients, and even colors. (More on colors later.)
Any object can be filled with the your company logo, the exact
blue of your newborn's eyes (using RGB or CMYK), or a linear
gradient, changing slowly from pink to red at a 60-degree angle.
You can  easily add shadows to any object, controlling the size,
color, and transparency of the shadow. 

Text
For technical illustrations with explanatory text, company logos,
or your family holiday card, the StarOffice application suite
gives you the tools you need to do the job, and the toys to make
it fun.

Full font selection  It's the same full feature set you get in
Writer, Impress, and throughout the StarOffice application suite.
You've got fonts from Abadi and Ariel through Verdana and
Windings, in any color or size, with any amount of expansion or
condensation , and in any position from superscript to
subscript.

Text in objects If you've ever done an organization chart, a UML
diagram, or other designs that require text on top of various
objects, you know it's a hassle to draw the shapes, position the
text frame on top of the shape, select the right object when
you're ready to write the text, and so on. Draw does away with
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the old two-step process: now all you do is draw a box that
represents your vice president, for example, then double-click
and type her name. (If you don't want to switch to the text tool
when you double-click, just turn off the feature in the option
bar below the drawing.) Control the size, color, font, and other
features as you would normally, as well as whether the text
wraps in the object or goes outside the boundaries.   

Text of every kind and variety There are six options on the
Text toolbar in Draw. You have regular text that retains its size
to whatever you set. The second option is text that
automatically adapts to the size of the text box you draw; if you
don't know the exact font size but know you want the text as
big as an object you've already drawn, just draw the box to
match the object, and you won't have to do any more fiddling.
The third option  is automatic callout boxes for technical or
educational drawings, so you can easily provide explanatory
text without a lot of hassle. Just draw the callout box, move the
line to the object you want to describe, and type the
information in the box. Show the outline of the box, hide it,
give the text a background color, or choose other option as you
see fit. 
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And just when you thought you had what you needed, the other
three tools are the same — except they're turned 90 degrees, so
you can have vertical text in all three flavors, too. For technical
diagrams, posters,  other designs with text down the side, or
special printing needs, the StarOffice application suite contains
all the options you need to make your projects work.

Animated text In Impress, you've got a glorious range of special
effects for text and objects. Draw has text toys, too, in the form
of text animation. This is in addition to
the text effects and marquees in Impress.
Just go to the Text Animation tab of the
text formatting window, and choose
blinking or three scrolling options. You also control whether it's
continuous, the delay if any, and how far apart the scrolling or
blinking is. And as you see, you can easily paste your text into
Writer or other StarOffice documents.

Go nuts with FontWork If there's still stuff you need to do with
your drawing's text that the other features don't cover, you'll
find it in FontWork. (It's in Impress, too.) Curve it, turn it upside
down, turn it on its side. You can control the direction not only
of the whole line of text — whether it goes from northwest to
southeast, for example — but what direction each letter faces: Is
it upright, upside down, or following the curve of the line? Add
a colored shadow for extra impact. Whether you're a
professional graphic artist or you just enjoy designing the
family newsletter each year, FontWork makes the job more fun
and gives you the power to go beyond what you've done before.
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Color
It's easy to be simple or complicated with StarOffice Draw
colors. Click what you want from the colors provided, or choose
an entirely different color model and make your own palettes.

Two color models You get CMYK or RGB — that is, the Cyan
Magenta Yellow Black (CMYK) model for professional printing
and design, or the Red Green Blue (RGB) model for standard
color work. 

Create your own colors and palettes If you do projects that
require a sophisticated handling of  colors, you've probably
wanted to change a color — maybe just a hair brighter than the
standard green, but without the blue undertones. The  Color
window lets you do exactly what you want; just punch in
specific RGB or CMYK values, and your custom color appears.
Specify hue, saturation, and brightness for even more control.
Save it under a new name and it's yours to use whenever you
want. 

The StarOffice application suite not only gives you the power to
create any color you want, but makes it easy to organize and
find your custom work. To keep your  custom colors separate, or
if you create several sets of colors to be used in different
documents, just store them in separate color lists or palettes. In
every  color window (and when you create crosshatches,
gradients, and bitmaps, too) you have the option to load a new
palette, save new or modified items in the same palette or  in a
different palette. 

Standard color editing support  The StarOffice application suite
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gives you the tools you expect for editing any raster graphic:
you can specify on-the-fly color depth , RGB values, black/white
values, contrast, gamma values, and brightness. When you select
a raster graphic, the editing toolbar appears above your drawing
area, conveniently giving you the tools you need, when you
need them.

Change individual colors in a raster graphic Anything made up
of pixels, like a picture you've scanned or a JPEG or similar file
you've opened, is a raster graphic. The colors are all in one
object, not separated into different shapes, so it can be a hassle
to change a color — to take the red eye out of scanned photos,
for instance, or  change a logo's bright green text to a softer
sage color. Without the proper tools, you have to sit there with
your face next to the monitor, changing one pixel at a time.
However, it's quick and easy with the eyedropper tool. Just move
your mouse over the color that you want to change, and click.
Then pick what you want to change it to: any color in the list, or
transparent. You can even specify how close you want the
change to be; if you just want any light green, more or less,
changed to sage, choose a wide range of error; if you want only
that particular shade of lime to be changed, choose a low range.

Note  You can convert any vector object to a raster — see the
type conversion information under  “Importing and Exporting
to Other Formats.” You can use the Eyedropper tool only on
raster objects to change individual colors; see the “Color”
section.
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3D Objects

A lot of designs look great with just flat drawings, but you can
throw a bigger visual punch with objects rendered in 3D. In
StarOffice Draw it's quick, easy, and the control is amazing.

What's a torus? It's not just spheres and cubes — you also get
cones, cylinders, shells, half-spheres, pyramids, and toruses —
(that's a donut, by any other name). If you've already got a
shape that you wish was 3D, just right-click on it and convert it.
For additional shapes, ovals get a whirlpool in the middle. You
can even convert text to 3D.

3D effects and formatting  Going through the formatting
window is an education in itself. First, there's the selection of
special predefined 3D formatting effects : shadowing, special
textures, gradients, designs, and more. Go into each subsequent
tab where you can control aspects like shading (flat, phong, or
goraud) and illumination ( light source and ambient light) and
you might not get through all the options. The preview window
always shows how your choices will affect the selected objects,
so you can get the effect exactly right before you apply it. For
sheer unadulterated fun, take some text, mess around with it
using FontWork, then bring up the 3D effects.
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Extra object effects
Combination platter You can group objects, of course, so they
behave as one when you apply effects or position them. You
can also combine two or more grouped objects, merging them
so they're the sum of their parts (combining and merging); so
they're just a set of connected outlines (connecting); so only the
overlapping part is left (intersecting); or so only the part of one
shape that is not overlapped is left (subtracting).

Distortions and curves ahead
Just as you can curve and
manipulate text with
FontWork, the distortion and
curve tools give you a lot of
control over an object after
drawing it. Squares and
circles have their purposes,
but for sophisticated designs
and original art, you need
more, and StarOffice Draw
gives it to you. Want to create
a CD cover design? Just draw
a rectangle, then use the Set
in Circle tool to curve it to
match the CD shape and
width. If you need a gentler
curve for the slope of a hill or
a precise shape in a design,
use the Set to Circle tool. To pull an object all over the place
without a circle as its central shape, use Distort; to manipulate
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specific points along its edges, convert it to a curve and use the
Bezier tool. 

If all you want is a simple slant, open the Size and Position
window to choose the angle of the slant.

To open up an object, filled or not,
just choose Break and drag the
lines where you want them. A
circle turns easily into a horseshoe
shape; a square courtyard in your
house plan changes into an open
one. It's a simple alternative to
drawing the shapes freehand.

Crossfading You can get dramatic
effects with crossfading. It
gradually transforms one object
into another, changing color,
shape, and texture in as many
increments as you specify. Give
the object borders, and you can
see how it changes; leave the borders off, and you can create a
variety of shapes from the resulting transformation. If you're
creating animations, this can save a lot of time.

Making a shaped series of objects The Duplicate feature is
similar to crossfading, but lets you start with just one object and
go wherever your imagination leads. Pick an object, then decide
how many copies to make, how much the height or width
should change in each subsequent copy, what color the first and
last objects should be, how much to rotate each copy, and how
far apart each copy should be. Need twelve copies of an object
for a clock face? Just specify  11 copies, with a 30-degree rotation
and spacing appropriate for the clock size. Need to create a
waving line of people from  a single piece of clip art? Make 12
copies that rotate out at 180 degrees, then copy the whole line
and flip it horizontally. Spirals have never been easier.

Filters  As good as you are at graphic design, there are some
things you'd rather have done for you. Making a picture look
aged, for instance, for a design illustrating 19th century pioneers,
or creating a modern pop-art effect for a movie poster.
StarOffice Draw comes with effects like these and more: eleven
filters in all. From color inversion to charcoal sketch, from relief

Product Guide 72



to mosaic, you've got powerful tools for dramatic effects.

Positioning and Sizing Objects
If you need control over positioning and size, you need the
StarOffice application suite. 

Put it where you want it  When just clicking and dragging isn't
enough. It's right there in the Size and Position window. For
whatever measurement system you're using, you can specify
exactly where the specified corner of the object should be on
each axis. Control the position to within 1/100 of a millimeter.
Apply this control to objects or text boxes. 

Size matters You've got the same precise control over an
object's size; just enter the width, maintain the same ratio or
enter the height as well, and click OK. Use this control on text
boxes, too. And of course, for approximate resizing, just click on
a corner to shrink or grow the object.

Grids and points for visual and automatic guidance The grid is
a set of intersecting lines, at intervals you specify, across the
work area. You can use them as a visual cue as to where to
position objects, for just a little help, or to make everything
snap (align) to lines and points on the grid. You can even set up
extra points in the work area that you want to use as visual or
snap guidelines — totally unrelated to the grid. Or choose to
snap an item to another item's border, so they're connected
precisely. 

It's all a matter of scale  If you want to work in a specific scale,
just look up the General options in the Draw setup window.
Select 1:2, 1:16, or whatever scale you need.
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StarOffice Road Test:  A Day
in the Life

Adopting a new office suite is a big decision, so we want to
make sure you know how the StarOffice application suite can
help you out on a day-to-day basis. Here's how four people
might use StarOffice for fun and profit. Pick the one that
matches your life the best, or read them all to see how you can
put the vast set of StarOffice features to work for you, saving
time, effort, and a whole lot of money.

Public school principal or teacher If your school is one of the
many  that tries to make up for limited funds by putting extra
demands on teachers, the StarOffice application suite is a great
way to get the software you need to produce lesson plans, track
grades, create attention-getting presentations, and get your
students excited about using computers.

Technical consultant When you're working for a different client
every week, time is money, but so is flexibility. You never know
what kind of software or platforms your next client will be
working with, so the StarOffice suite's ability to open any file
created on any platform enables you to work with anyone, no
matter what format their source documents are in or how they
want the product delivered.

Small business owner When you're trying to run your dream
business and turn a profit, too, constant expensive upgrades
and software that locks you into a single vendor aren't much
help in achieving your goals. StarOffice software, the affordable
and flexible choice, is on your side in the struggle to make it to
the top. It provides everything you need in one package, from a
database of your key clients to your marketing brochures, Web
sites, and presentations to prospective customers.

Just for fun The drawing, graphics editing, and font capabilities
of the StarOffice suite are so rich, there's virtually nothing you
can't do. Whether you're making your personal Web site, the
cover art for your mix CD, the family Christmas letter, or any
other project, the StarOffice 3D graphics, FontWork, and the
seamless integration of tools across applications will help you
create whatever your imagination dreams up. 

StarOffice in Public Schools

Sierra Elementary school in Petersburg, Montana is a typical
public school. The principal tries to get the best equipment and
materials with the budget she has, but usually it's a struggle just
to maintain standards. The teachers love teaching. However, the
extra hours spent outside class correcting papers and tracking
grades, and being responsible for creating anything outside the
standard curriculum that might make class more interesting,
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can be frustrating. Everyone, including the students, is bored
with the way they learn and do homework: chalkboard,
workbooks, photocopied handouts from five years ago. 

Decision-makers
The office suite for any budget, on any scale The principal had
planned to convert from an ancient, character-based WordStar
word processing program to something a little more up to date,
but a site license for all the school's computers, including the
ones in the computer lab, were beyond what the budget could
handle. She had also investigated the cost to convert the
school's files, including student and teacher records, class
materials, and so on, and it was prohibitive. 

However, at an education convention she attended at the
beginning of the school year, the principal found the StarOffice
application suite. She discovered that not only was it affordable
to install throughout the school, but there were no conversion
issues from WordStar, AmiPro, or  other old formats the school
had used — StarOffice software could open everything they
needed. It also meant that students with  computers at home
had no excuse for not having the StarOffice suite. This opened
up a  new set of options for homework, as well as ways to get
homework done when students were out sick or on trips.

Painless knowledge migration  She checked out the ease-of-use
factors. The StarOffice feature set was robus,t but it looked like
the AutoPilots would help inexperienced users get started
quickly, and the online knowledge base provided by Sun

Microsystems would answer any  questions they had. 

Operate in the same low-cost environment  The principal was
also considering using the Linux platform on new computers
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that were added to the computer labs and faculty offices. A low-
cost, open source operating system was as appealing as a low-
cost, open source office suite, and now she knew that they
worked together beautifully. She ran the demos of the
StarOffice application suite on Linux, Microsoft Windows, and
the Solaris Operating Environment, and couldn't see a difference
— which meant no issues when the teachers brought in work
from their home computers for students to use in the school
computer labs. With no costly  upgrades for operating system or
office suite, she thought she'd be hard pressed to find a reason
to buy anything else.

Teachers
Tools for quick grade calculation Most of the teachers spent
hours of extra time each week outside the classroom, grading
papers and tests and figuring out what that meant for the
students. The end of each quarter meant even more extra time,
entering and calculating final grades, worrying about how to
evaluate intangibles like class participation, and so on.

One of the history teachers took an evening to look at StarOffice
Calc, the spreadsheet program, to see how it would work for
storing and calculating grades. She opened up her plain text file
where she currently tracked everything, and quickly imported it
into Calc. All the students' grades on each assignment were now
in an easy-to-read-and-manipulate spreadsheet form. She used a
simple formula to add weight to the three big tests she'd given
that quarter, then with help from the AutoPilot function, added
a formula to average the weighted grades together and display
them with the corresponding letter grade. The average grade
came out a little low, with only two As, and she remembered
that the second test had been on a few chapters that the
substitute teacher hadn't covered in class. She also added a
column for class participation, based on the points she gave
each day for comments in class and whether the student had
grades for every pop quiz, and looked at the letter grades again.
This time, the results didn't surprise her, and she knew these
were grades she could hand in and stand behind. She could also
use the spreadsheet later as a data source for reports, or even to
do a mail merge to send parents personalized reports of their
children's performance.

Liven up the classroom The next day's lecture was on the
Copernican revolution: how the assertion that the earth
revolved around the Sun caused an uproar in Renaissance
Europe. The usual approach was to discuss the textbook and
look at a map or two. However, she decided to try  out the
presentation application, Impress, and see what she could do.
She created a few slides on background information using bullet
text, and adding an attractive background design that came
with Impress. Then she read on about the convoluted circles
that mathematicians had drawn to represent the sun and other
planets rotating around the Sun. So she used the special effects
animation tool to make each of the planets move along its
orbit, and ran the presentation. This was a lot more interesting
than her usual lecture, and it really brought home the topic, as
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well.

Students
Creative
homework  
The primary
exported products
of Paraguay have
rarely brought
much excitement
to anyone, but the
way  students are
asked to produce
their homework on
a topic can make it
go faster and be
more interesting,
too. 

Creating a Web
page on South
America, with an
image map that enables you to click on Paraguay to see
information about it, helps make class more interesting, and
less of a struggle to get homework turned in. Any student with a
computer can afford StarOffice software, regardless of their
home budget.

Work from home A few students each year had problems being
in a real classroom — caused by social awkwardness, attention
problems, getting to school from remote areas, and so on.
Usually they switched to home schooling or dropped out of
school altogether. The StarOffice suite, looked like a great
solution to the problems these students associated with being
on site, while still enabling them to take advantage of the public
school system. Teachers could easily distribute their materials,
distribute tests for students to fill in and e-mail back. An
increasing number of teachers were asking their students to
work from home, anyway: go to a Web site and research a topic,
create a presentation on subjects found on the Internet, and so
on. And for parents who take their kids on two-week family
vacations every year, it's easy to load StarOffice software on a
laptop to help the kids keep up with their homework, instead of
the inevitable rush upon return, and the plummeting grades
that can result.

StarOffice and the Consultant

Olav Roberts has been riding the technological revolution for
years. Starting as a programmer in the core of Silicon Valley,
he's now a successful consultant, traveling all over the world to
train beginning or advanced programmers, give presentations
on new technologies, and anything else a client might request.
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Olav has used Microsoft Office on his laptop for years, so he
could nearly always read his client's files and send documents in
their preferred  format. He fell in love with the Linux platform
and switched as soon as he could, but then he had difficulty
producing documents for his clients in the format and software
they demanded. However, when he saw the StarOffice
application suite at a technical conference, running on Linux as
well as the  Solaris Operating Environment and Microsoft
Windows, he knew this was just what he needed. He had the
software up and running on Linux before he caught the flight
home.

Speak any software format language He made a lot of useful
contacts at the conference, including a new client who asked
him to create customized Java training in three weeks. Olav had
standard PowerPoint files containing boilerplate training
materials, so he ran the StarOffice Microsoft import filter, and
the files opened in StarOffice perfectly, with all formatting
intact. He knew it  would be easy to save the StarOffice files
back into Microsoft format if the client wanted copies. 

Opening his Excel time sheet template in StarOffice Calc, Olav
filled in the time he'd spent already. It wasn't much, since the
rough draft and formatting were completed before the flight
was over. To fill the remaining time, he added the contacts he'd
collected at the conference to his own address book, then used
the address book AutoPilot to connect it to the database
management feature in the  StarOffice suite. He'd now be able
to use the StarOffice database to run automatic mail merges,
sending letters to all his contacts, or just the new ones. When
Olav got off the plane, he'd accomplished a lot more than he
usually did while traveling.

Collaborating and reviewing easily As he started working on
the project back at the office, Olav insisted on getting feedback
on his materials before showing up to do two weeks of training
for 100 people. He wanted to use the StarOffice versioning and
editing comments features, so he asked the client to download
and install the StarOffice application suite. Normally he'd have
to pay for the cost of any accommodations he asked the client
to do, but with StarOffice 6.0, his client contact had the software
downloaded and was reading Olav's document within an hour.

It turned out the edits were heavy. The client wanted a lot of
new things that hadn't been mentioned before. After seven
rewrites of the document,  Olav ended up going back to version
five, due to a miscommunication with the client. Normally he'd
have overwritten that version and would be desperately
searching through his backups for it, but the StarOffice version
control system made it easy to bring up the correct version. He
also faxed each one straight from the StarOffice suite to the
company VP, who didn't use e-mail, but liked to be kept up on
how things were going.

Being prepared  Olav left for the client site and, on the flight
over, timed the training with the StarOffice Rehearse Timings
feature. Allowing time for the lab exercises and a few breaks, he
discovered he was about a half-day short on material, so he
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quickly imported some FrameMaker documents on the history
of the Internet.

Customize slide output for any situation Arriving at the client
site, Olav met the team and, of course, there were a few
surprises. He discovered that he was not only training a
hundred programmers over the next two weeks, but the
managers would be sitting in on the classes as well. They
wanted him to cut the class down to four days, since they
couldn't be away from their jobs any longer. He managed to
convince the managers to allow him to create specialized
training, and quickly produced a customized presentation from
his main training file, taking the first slide from every chapter,
which contained the overview information. Olav didn't have to
do any cutting and pasting, since Impress enabled him to create
a different version of the presentation  based on the same
source file. He made a few changes to the slides in the custom
presentation, which also showed up in the original version for
the programmers. 

A few managers were at a conference and couldn't attend in
person, but Olav solved that problem and scored big points with
the customer by quickly converting the custom presentation to
a Webcast. He made a version in plain HTML too, without
frames, to make sure every remote manager could read the
materials.

Easy look-and-feel customization with slide templates and
styles  The night before the training was going to begin, Olav
discovered that the presentation absolutely had to look like all
the company's existing documents and presentations. He
imported a sample template and created an Impress template
from it, quickly verifying that it had all the styles he needed for
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his presentation's content. He customized several styles for the
Code Example and Notes styles he needed, then applied the
template to his presentation. Even the standard background,
which showed the company president emerging from a  cloud
bank at the top of  Mount Hood, blended in pretty well, now
that he'd applied a black-and-white charcoal filter effect to the
JPEG file to make it a bit subtler.

The training went beautifully; the managers were pleased that
they'd receiving customized training, and the programmers
genuinely understood object-oriented programming by the end
of the two-week session. The client gave Olav a huge list of
colleagues who also needed training. The list was in a dBase file,
one of the many formats supported by the StarOffice suite. Olav
got on the plane feeling good: the usual last-minute changes
hadn't kept him up all night converting and formatting, and
he'd spent time doing work he enjoyed, not struggling with the
software.

StarOffice and Your Business

Kathy Jones started her travel agency last year. Specializing in
guided package tours, she's put together a business that's
starting to thrive, though with a few issues still to work out. She
has enough work; but finding time to do it all or train someone
to help is a problem. Kathy's also trying to create a more
polished image, so she can attract business travelers for
weekend spur-of-moment tours she's developing. Her target
market is professionals who are stuck in a strange town over the
weekend  with nothing to do.

Kathy's goal, in addition to cutting expenses wherever possible,
was to find software that would let her get as much done as fast
as possible. Spending time on the software, teaching it or
learning it or redoing work was a waste of time that could be
better spent sleeping or trying to recognize her husband and
children. A colleague had recommended the StarOffice
application suite, so she downloaded it from Sun's Web site. She
was expecting an evaluation copy that would expire in a few
days, but she received the whole package, and a half hour later
had it installed, set up, and running. She chose to do the
optional registration, since it gave her access to the dozens of
knowledge base sites and forums about StarOffice.

Single source: less work now, less work later Kathy needed to
get out the word about her new tours, in a lot of different
formats. She had a standard press release that a contract
marketing writer had created for her using Microsoft Word. But
she also needed an intimidating number of sales tools: a Web
page, brochures, mailings, sales presentation she could deliver
herself, as well as a Webcast sales presentation that could run
automatically. And each of them would need frequent updating
as tour package details like price, dates, and specials changed.

Opening the Word marketing document with StarOffice Writer
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was easy. Looking through her StarOffice book and the menus,
Kathy  began to  realize that once she had a StarOffice Writer
document, it could go anywhere.

First, Kathy broke the ten-page document up into several
smaller documents, by topic:  business overview, general
information on the new line of tours, details on tours, pricing,
and so on. She didn't want to
include everything in all her sales
documents, but didn't want to be
deleting and adding all the time,
so she decided to use the Insert
feature. Kathy stored the files in
a SOURCEFILES directory and
started planning how to use
them.

The Web page would contain
everything, she decided. Kathy
opened a new HTML file and
inserted each separate content
file. She applied an elegant-
looking design layout, then  used
the target feature to easily add
links to each topic in the page.
The Web page was done.

The brochure was next. Kathy
opened two new Writer files,
saving one as business_brochure
and one as newtour_brochure. She inserted a few  source files in
each, added her company logo and an appropriate title to the
first page, then converted her standard Word template to
StarOffice format and applied it to both documents. Going to
the print setup window, Kathy  chose brochure printing and
printed several copies of each  two-sided folded-page brochure.

Mailings were just as easy. First, Kathy organized all her
contacts  by opening up her plain text address book in Calc,
turning it into a spreadsheet. She used that as her data source
for the mail merge, since a database isn't required by the
StarOffice application suite. Then Kathy  used the AutoPilot to
create a letter, using her contacts spreadsheet and its
Gold/Platinum members query as the data source.
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Kathy added some basic introductory text, inserted the
overview and a detailed tour source file, and finished it with
standard signature text. Both the letters and envelopes printed
without a hitch.

For the sales presentation, Kathy created another new Writer
skeleton file and inserted everything except the more detailed
source files. She applied a standard Writer template and
assigned Heading1, Heading2, and Heading3 styles to the points
that she wanted displayed in the slides; she'd just talk about the
rest without distracting the audience with excess detail. Then
she chose the Send Outline to Presentation command, and in a
few seconds had a new set of Impress slides. Kathy applied her
standard PowerPoint template to it, and the sales presentation
was done.

Once she had the presentation slides, it was easy to make the
Webcast equivalent. Kathy  exported the presentation to HTML,
then chose the appropriate Webcast options. Now she had a
sales tool that could run constantly on a Web site, selling her
tours to anyone watching.

Later, when she needed to change details, Kathy  went to the
source files. Updating the Writer documents was as easy as
opening the files, and the presentations were also simple to
regenerate. No cutting and pasting, no updating one output
version but not another, and no wasted effort.

Figuring out how to achieve specific financial results Kathy's
business advisor helped her determine how much to charge for
tours, the expenses she could include with each package, and so
on. However, Kathy also  wanted a tool she could use to figure
out “what if” scenarios when she had a new idea. She wanted to
know if, when people suddenly canceled, could she still afford to
give a tour  if she increased the cost by x% and got y more
customers; if she gave a partner x% of the proceeds of a tour in
exchange for a y% discount on their product; and was it worth
her while, especially if she had to hire someone to help around
the office this fall? How many extra Wine Country tours would
she have to sell this year in order to buy a small lake cabin she
had her eye on; how many for the big lake cabin? It took a long
time to figure out multiple outcomes of these scenarios using a
calculator or standard financial spreadsheets. 

However, the StarOffice Calc spreadsheet comes with powerful,
intuitive scenario capabilities built right in. All Kthy had to do
was set up a separate spreadsheet for each situation she wanted
to figure out, add only the formulas she needed (creating them
there or copying them from other financial spreadsheets), then
create a drop down list for the variable she wanted to fiddle
with. 

Streamlining work for employees Kathy had more than
enough work for someone to help her in the office creating
quotes, putting together tour and sales materials, and so on.
However, she'd heard horror stories from colleagues who'd
spent three months training someone who still was more work
then help. The labor market was tight, and she wanted to make
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sure that whoever she hired could come up to speed quickly on
the tools and processes she used.

Kathy knew that her employee would need to be able to
produce quotes correctly, without supervision. As a sole
proprietor, she didn't have the expensive software that would
shoot out quotes automatically. Instead, Kathy had put together
a quote-generating spreadsheet in Calc, which was like a little
software program of its own. She could enter the type of
package, number of days, and several other variables to get the
standard cost, member cost, or commercial cost. It was a
powerful set of calculations, and since she customized it for her
own business, it was easier to use and more helpful than the
expensive software she'd been eyeing. Easier to upgrade, too,
when her business changed.

However, to get the right results it was crucial to enter only
valid values. For instance, for the European package, she had to
make sure to enter the right number of days, the right hotel
(spelled correctly), and so on . The calculations contained
complex If/Then statements based on the hotel and other non-
number values, and she only had two tour lengths, seven and 21
days. This meant that entering 18 days would throw everything
off. Kathy didn't want to  document all the rules and
possibilities, nor did she totally trust her assistant to closely
follow every single instruction. 

It was easier to build the values into the system. Calc enabled
Kathy to create a drop down menu of the possible values,
wherever  this was necessary. Tour length for European tours
became a list that offered only seven and 21days as the possible
choices; hotels on the Wine Country tour became Ephraim's and
Vicente's. If she received contracts with additional hotels or
changed any other details, it was easy to update the
spreadsheet.
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Finally, Kathy created a new Calc scenario to figure out how
much she could pay the assistant, taking into account taxes and
all other costs, to determine what wage she could offer and still
continue with her profit growth goal for the year.

Kathy felt a lot more confident about hiring an assistant now.
She knew how it would affect her financially and that she could
expect a fast learning curve with her software and virtually
mistake-free quotes. Kathy had all the sales literature already
completed in multiple forms, so she could easily point out
which types to distribute. And best of all, she knew the big mail
merge project she'd been putting off for months, letters to all
4,000 of her contacts nationwide, would be easy for her new
employee to accomplish.

Professional-looking graphics However, Kathy was still
dissatisfied with the look of some of her tour photos. The big
travel agencies had such professional, glossy posters and tour
guides. While she knew she wouldn't have the money to create
anything on that level for a while, she wanted to upgrade the
illustrations she used for brochures and the framed pictures in
her office.

Sitting down at the computer with her StarOffice software
again, Kathy scanned in some photos from her new tour
package, including  spectacular sunsets and landscapes. They
looked all right, but not quite eye-catching enough. So she
found the image toolbar and started adjusting values: the
balance of red, green, and blue in each photo, color saturation,
brightness, and so on. An underexposed mountain shot
brightened up beautifully, a lakeside landscape looked markedly
better in black-and-white, and a well composed but
unremarkable sunset became stunning when she applied the
Aging filter and slightly increased its blue saturation. She
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quickly added the
sunset to the front of
her latest general
sales brochure. 

Kathy decided to send
a few of her other
photos to a
professional printer
to produce framed
artwork for the office.
She asked the printer
about specific
requirements, and
found that it was easy
to do in Draw. Kathy
switched the color
model to CMYK, the
color model preferred
by professionals, and
saved the file in TIFF
format. She also sent off the company logo in EPS format to the
custom t-shirt shop, to be printed on new polo shirts for herself
and her new assistant.

A productivity tool that actually made her more productive. The
StarOffice application suite was the best business decision Kathy
had made in a long time.

StarOffice for Fun

Anthony discovered the StarOffice application suite while
surfing Amazon.com a few weeks earlier, checking prices for
Adobe Photoshop, Microsoft FrontPage, and the other software
he wanted. Most of them were very expensive, but the StarOffice
suite was quite affordable. He had already downloaded some
limited freeware graphics programs, and had a WYSIWYG Web
editor, but every time he wanted to do something out of the
ordinary, he was stuck. 

The first thing Anthony did with StarOffice 6.0 was get his basic
Web page framework down. He had a hard time choosing from
the 14 different templates and 19 layout designs, but  he finally
settled on a one-column template with placeholders for pictures
and captions, and a basic yellow as the background color
scheme. 
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The main page
was decorated
with a picture
using a style
Anthony had
always wanted
to try: a photo
of himself, with
an Andy Warhol-
style, high-
contrast effect
applied to it.
Inserting a
picture from the
last band party,
he used the red,
green, and blue
controls for
graphics editing.
It took a few
seconds to add
his name and e-
mail address in
a mailto link, so
clicking the link
opened a new e-
mail document
addressed to him. Anthony's  main page was ready.

The Warhol self portrait turned out so well that Anthony
decided he wanted it on every page as an identifying icon. He
made an animated GIF, so that every second, the image changed
from red to blue to green. He placed it in the lower left corner of
every page, and hot linked it to his e-mail address.

Anthony wanted to accomplish several things with his page —
distribute his original woodworking plans; publicize his band;
and display his resume.

Rendering and posting designs Up to this point, Anthony had
hand drawn the plans for his original furniture and guitar
designs, and scanned them into his computer. The professional
AutoCAD package was way out of his budget, and most other
software didn't seem to give him what he needed. Drawing the
plans for a kitchen table, though, was easy  in StarOffice Draw. A
grid enabled him to visually position and size the lines and
components, while the Position and Size window helped him
utilize measurements. The Bezier curve allowed Anthony to
precisely outline curved lines; while the dimension lines and
scale tool showed the exact finished measurements of each part.
Anthony finished his design quickly, without getting mad at the
computer even once. 

Once done with the drawing, he exported it to JPEG, shrank it
down to thumbnail size, and inserted it in a new HTML page.

Anthony was about to add text links on his new woodworking
page to all his existing plans, when he realized it'd be a lot more
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useful to show the furniture itself. The bed was still in the
garage with several of his other projects. Using his digital
camera, Anthony shot a photo and loaded it into his computer.
He inserted the picture into the woodworking HTML page, and
used the StarOffice image map feature to link the right piece of
furniture to the plans he'd drawn and scanned for it. In the
image map tool's window, Anthony drew a circle around each of
the pieces of furniture, then entered the URL of the plans for
that item. 

Getting the band back together Anthony was in a band that, if
they practiced, might be pretty good. Publicity would help, too.
He'd taken a stab at a poster and logo awhile ago, but it was
time to produce something really professional-looking.

New HTML page, first. He started with a dark gray background
and white letters, then switched to the raw HTML so he could
tweak the text color a bit, giving it just a hint of blue. Anthony
placed a flashing marquee at the top of the page, announcing
that the band was back and playing at Kirby's next week. 

A poster was next. Taking a few head shots from various
snapshots he'd scanned, Anthony opened StarOffice Draw and
superimposed the faces on a pyramid he drew with the 3D tool.
He fiddled with a few of the filter effects on the photo, trying
charcoal, pop art, and posterizing, but eventually settled on
relief. Using the duplicate tool, Anthony created a border for the
poster, repeating the pyramid image at intervals around the
drawing. 

The band had written a few new songs that needed to be
recorded, so a new CD cover and label were in order, too. The
cover was easy — Anthony  measured a CD jewel case and used
the resize tool to shrink his poster to exactly those
measurements. The CD cover was another challenge, though.
How would Anthony get all the names of the songs onto the CD,
curved to the same shape? Just in time, he discovered the
FontWork and Set in Circle tools. He used the Set in Circle tool
to create the background, a two-inch thick circle with a half-inch
hole in the middle. He gave it a narrow outer ring of black and
made each quadrant of the circle a different color. Then
Anthony  imported the band's name, Psychedelic Chipmunks,
and the song titles, so FontWork could curve the text in the
same shape as the CD. 
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Getting a job the easy way Anthony hadn't updated his resume
in awhile, mostly because it was in Word 5 for Macintosh. But it
opened easily in StarOffice software. He scrolled through the
Writer templates available, marking Preview so he could see
each one without opening it, and found a resume template he
liked. Anthony updated it with a few skills, adding "expert
StarOffice knowledge" under the technical skills heading, and
added hyperlinks to some Web sites he'd designed. Then
Anthony saved it as HTML and Word format for posting on the
Web site. 

Drafting, design, marketing the band and himself — all with one
piece of software that cost less than a Word upgrade. That pretty
much disproves the adage, “you get what you pay for” when it
comes to the world of office suites.
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Sun Microsystems
901 San Antonio Road
Palo Alto, CA 94303

1 (800) 786.7638
1.512.434.1511

www.sun.com/staroffice/
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